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Safety Instructions

Safety Instructions • English

 WARNING:  This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within 
the product’s enclosure that may present a risk of electric shock.

ATTENTION:	  This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron website, 
www.extron.com.
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FCC Class B Notice

NOTE:	 This device complies with part 15 of the FCC rules. Operation is subject to the 
following two conditions:  
(1) This device may not cause harmful interference, and  
(2) This device must accept any interference received, including interference that may 
cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC rules. These limits provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communications. There is no 
guarantee that interference will not occur. If this equipment does cause interference to radio 
or television reception, which can be determined by turning the equipment off and on, you 
are encouraged to try to correct the interference by one or more of the following measures:

•	 Reorient or relocate the receiving antenna.

•	 Increase the separation between the equipment and receiver.

•	 Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

•	 Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with 
this equipment. Operation with non-approved equipment or unshielded cables is likely to 
result in interference to radio and TV reception. The user is cautioned that changes and 
modifications made to the equipment without the approval of the manufacturer could void 
the user’s authority to operate this equipment.

NOTES:		 For more information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics see the Extron Safety and Regulatory 
Compliance Guide on the Extron website.

https://www.extron.com/68-290-01
https://www.extron.com/68-290-01


Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

 WARNING:	 Potential risk of severe injury or death. 

AVERTISSEMENT :	 Risque potentiel de blessure grave ou de mort.

CAUTION:	 Risk of minor personal injury.

ATTENTION :	 Risque de blessure mineure.

ATTENTION:	

•	 Risk of property damage. 

•	 Risque de dommages matériels.

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C
[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2#* X2! CE}

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” is the capital 
letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32
C:\Program Files\Extron

Variables are written in italics as shown here:
ping xxx.xxx.xxx.xxx —t
SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.

Extron Glossary of Terms
A glossary of terms is available at https://www.extron.com/technology/glossary.aspx.
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Introduction

This section gives an overview of the Extron NetPA Ultra Series: NetPA U 1004, 
NetPA U 1004-70V, and NetPA U 1004-100V, as well as the NetPA U 1002, 
NetPA U 1002‑70V, and NetPA U 1002-100V. The NetPA Ultra Series is a collection of 
4-channel and 2-channel power amplifiers. Topics in this section include:

•	 About This Guide

•	 About the NetPA Ultra Series

•	 Features 

About This Guide
This guide describes the NetPA Ultra Series: a series of 4-channel and 2-channel DSP and 
Dante enabled power amplifiers and discusses how to install, configure, and operate them.

In this guide, the terms “unit,” “NetPA Ultra Series amplifier,” “amplifier,” and “power 
amplifier” refer to the NetPA Ultra Series of power amplifiers.

About the NetPA Ultra Series
The Extron NetPA Ultra Series NetPA U 1002 and NetPA U 1004 are Dante-enabled, 
ENERGY STAR® qualified power amplifiers that deliver two to four 100 watt channels in a 
half rack, 1U, plenum rated enclosure. 

With their integrated DSP, the NetPA U 1002 and NetPA U 1004 include essential signal 
processing that offers the ability to meet the requirements of complex, decentralized 
systems, while Dante Domain Manager and AES67 support ensure wide compatibility with 
enterprise configurations and other network audio devices. Exceptional thermal design 
provides the ability to install units without using rack spaces for ventilation, conserving 
precious rack space. The NetPA U 1002 and NetPA U 1004 are highly efficient advanced 
Class D amplifiers that feature defeatable auto‑standby with fast wake up and our patented 
CDRS – Class D Ripple Suppression. 

Features
•	 Receives audio from the Dante audio network as well as from analog mic/

line level inputs — Select a channel from any remote Dante-enabled device on 
the network, or an analog source, to be brought into the NetPA Ultra Series for 
amplification. 

•	 100 watts rms output power per channel at 8 ohms, 4 ohms, or 70/100V — All 
channels driven.
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•	 ENERGY STAR qualified amplifier with defeatable auto-standby and fast 
wake up — Both the NetPA U 1004 and NetPA U 1002 are ENERGY STAR qualified 
amplifiers and energy efficient products that conserve energy and reduce cost. Both 
amplifiers meet ENERGY STAR qualification requirements with an auto-standby feature 
which automatically places the amplifier into Standby mode after 25 minutes of 
inactivity thereby dramatically reducing power consumption. And they quickly return to 
full power status in less than 100 ms upon signal detection, with minimal inrush current. 
Auto-standby can be disabled if required.

•	 Single and dual rack-mount hardware included — The included single and side-by-
side rack-mount hardware simplifies planning and saves cost.

•	 Integrated DSP — 

•	 The NetPA U 1004 has an 8x8 mix matrix which provides essential DSP 
processing including level control, filters, dynamics, and delay. 

•	 The NetPA U 1002 has a 6x6 mix matrix that does the same action: providing 
essential DSP processing including level control, filters, dynamics, ducking and 
delay.

•	 Convection cooled, fanless operation - can be stacked without extra rack 
space for ventilation — The NetPA Ultra Series does not require internal fans or vents 
for cooling, ensuring quiet and reliable operation. They generate substantially less heat 
than conventional power amplifiers, making them ideal for rack-mount applications 
where space is limited (see Rack Mounting Ventilation Recommendations on 
page 9). 

•	 Extron Patented CDRS - Class D Ripple Suppression — CDRS is an Extron 
patented technology that provides a smooth, clean audio waveform and an 
improvement in signal fidelity over conventional Class D amplifier designs. CDRS 
eliminates the high frequency switching ripple that is characteristic of Class D amplifiers, 
a source of RF emissions which can interfere with sensitive AV equipment such as 
wireless microphones.

•	 Four channels in a 1U, half rack width enclosure — The channel density of the 
NetPA U 1004 reduces rack space requirements for many installation.

•	 Remote control and monitoring — 

•	 Control and monitor the NetPA Ultra amplifier directly through the RS-232 port.

•	 Control the NetPA Ultra amplifier through a DMP Plus processor over a Dante 
network.

•	 Setup and configuration with Extron DSP Configurator Software — Via the Dante 
network or USB.

•	 UL 2043 plenum rated when used with optional Flexible Conduit Adapter Kit — 
The NetPA Ultra Series meets UL 2043 for smoke and heat release for installation within 
a plenum airspace above a drop ceiling when used with the optional Flexible Conduit 
Adapter Kit. Above-the-ceiling placement conceals the amplifier to prevent theft, and is 
convenient for installing equipment when space inside the room is limited. 

•	 Professional grade signal-to-noise and THD+N performance — The NetPA Ultra 
Series delivers professional grade performance, featuring 100 dB signal-to-noise ratio 
and THD+N of less than 0.1%.

•	 Ultra low inrush current at power up - no need for power sequencing — Allows 
multiple NetPA Ultra Series amplifiers to be powered on simultaneously without 
overloading power circuits. 
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•	 Power factor correction - removes harmonic content on AC line — The NetPA 
Ultra Series features power factor correction technology that smooths out the high peak 
currents of the amplifier current draw thereby minimizing the presence of high frequency 
harmonics on the AC power line and preventing audible artifacts from being transmitted 
to other audio equipment in the system. 

•	 Automatic clip limiter — Detects actual onset of clipping. Gain is automatically 
reduced without audible artifacts to protect speakers from clipping distortion.

•	 Multiple protection circuits — Activate during output shorts, thermal overload, or DC 
faults to prevent damage to the amplifier and speakers.

•	 Remote standby port — Enables the NetPA Ultra Series to be remotely powered 
down when not in use, reducing operating cost.

•	 High pass filter for high impedance models — The 70V and 100V models feature 
a fixed high pass filter on the amplified outputs to prevent saturation of speaker 
transformers.

•	 5 mm screw-lock captive screw speaker connectors — Enable simple, secure 
connections with 22 to 12 AWG speaker cables. 

•	 Front and rear-mounted signal and protection indication LEDs — Provide 
convenient indication of input signal presence and protection circuit activation from both 
sides of the equipment rack.

•	 Front panel over-temperature LED — Provides visual indication that the amplifier 
temperature has exceeded the optimal value, well in advance of the onset of thermal 
protection circuitry. 

•	 Internal Extron Everlast power supply — Provides worldwide power compatibility, 
with high-demonstrated reliability and low power consumption for reduced operating 
cost.

•	 Extron Everlast Power Supply is covered by a 7-year parts and labor warranty 
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Installation

This section describes the installation and setup of the NetPA Ultra Series of power 
amplifiers. Topics include:

•	 Mounting the NetPA Ultra Series Amplifiers

•	 Rack Mounting 

•	 Rack Mounting Ventilation Recommendations

•	 Flexible Conduit Adapter Kit

Mounting the NetPA Ultra Series Amplifiers
The NetPA Ultra Series amplifiers can be mounted in a rack using the included rack ears, 
mounted on a rack shelf, set on a table or mounted in the plenum space above a ceiling-
mounted projector. Also, two amplifiers can be connected using the bridging plate to create 
a full rack-width unit.

This guide uses images of the NetPA U 1004 to describe installation, but all the amplifiers 
are installed the same way.

Tabletop Use
Four self-adhesive rubber feet are included. Attach one foot at each corner on the bottom 
side of the amplifier and place the unit in a desired location.
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Rack Mounting
The NetPA Ultra Series amplifiers can be mounted onto a rack using one of the following 
methods.

NOTE:	 The following figures show the NetPA U 1004 being installed; however, both 
NetPA Ultra Series amplifiers are installed in the same way.

UL Rack Mounting Guidelines
The following Underwriters Laboratories (UL) guidelines pertain to the installation of the 
equipment into a rack: 

CAUTION:	 Risk of minor personal injury:

•	 Elevated operating ambient temperature — If the equipment is installed in a 
closed or multi-unit rack assembly, the operating ambient temperature of the rack 
environment may be greater than room ambient. Therefore, consider installing the 
equipment in an environment compatible with the maximum ambient temperature 
(Tma) specified by Extron. 

•	 Reduced air flow — Install the equipment in the rack so that the amount of air 
flow required for safe operation of the equipment is not compromised. 

•	 Mechanical loading — Mount the equipment in the rack so that uneven 
mechanical loading does not create a hazardous condition. 

•	 Circuit overloading — When connecting the equipment to the supply circuit, 
consider the connection of the equipment to the supply circuit and the effect 
that circuit overloading might have on overcurrent protection and supply wiring. 
Consider equipment nameplate ratings when addressing this concern. 

•	 Reliable earthing (grounding) — Maintain reliable grounding of rack-mounted 
equipment. Pay particular attention to supply connections other than direct 
connections to the branch circuit (such as the use of power strips).
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Consignes UL pour le montage en rack

Les consignes UL (« Underwriters Laboratories ») suivantes concernent l’installation de 
l’équipement dans un rack :

ATTENTION :	 Risque de blessure mineure :

•	 Température ambiante élevée — En cas d’installation de l’équipement dans 
un rack fermé ou composé de plusieurs unités, la température du rack peut être 
supérieure à la température ambiante. Par conséquent, il est préférable d’installer 
l’équipement dans un environnement qui respecte la température ambiante 
maximale (Tma) spécifiée par Extron. 

•	 Réduction du flux d’air — Si l’équipement est installé dans un rack, veillez à ce 
que le flux d’air nécessaire pour un fonctionnement sécurisé de l’équipement soit 
respecté. 

•	 Charge mécanique — Installez l’équipement en rack de manière à éviter toute 
situation dangereuse causée par le déséquilibre de la charge mécanique. 

•	 Surcharge électrique — Lorsque vous connectez l’équipement au circuit 
d’alimentation, observez la connexion de l’équipement et étudiez les effets 
possibles d’une surcharge du circuit sur les protections contre les surintensités 
et les conducteurs d’alimentation. Consultez à cet égard les indications de la 
plaque d’identification de l’équipement. 

•	 Mise à la terre — Assurez-vous que l’équipement est correctement mis à la 
terre. Accordez une attention particulière aux connexions électriques autres que 
les connexions directes au circuit de dérivation (ex. : les multiprises).

Rack Ear Mounting
The NetPA Ultra Series amplifiers ship with a set of rack ears, so that the half rack-width 
amplifiers can be installed in a full rack-width space. 

Mount the amplifier with the rack ears by doing the following:

1.	 Remove the rubber feet from the bottom of the amplifier if previously installed.

2.	 Attach the included rack ears (one long and one short) to the sides of the amplifier with 
the four provided #6 machine screws (see figure 1, 1).

e

NetPA U 1004 Series

1
2

3
4

OVERTEMP

LIMITER/PROTECT

SIGNAL

POWER AMPLIFIERS

1

POWER AMPLIFIERS

NetP

POWER AMPLIFIERS

NetP

POWER AMPLIFIERS

 

NetP

Figure 1.	 Installing Rack Ears onto the NetPA U 1004

3.	 Insert the amplifier into the rack and align the holes in the rack ears with the holes on 
the rack.

4.	 Secure the amplifier to the rack using the four provided 10-32 x 3/4” screws (see 
figure 2, 1 on the next page).

1  
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e

NetPA U 1004 SERIES

  

1
2

3
4

OVERTEMP

LIMITER/PROTECT

SIGNAL

POWER AMPLIFIERS

NetP

1

Figure 2.	 Securing NetPA U 1004 to Rack

Bridge Plate Rack Mounting
The NetPA Ultra Series amplifiers ship with a bridge plate connector to allow two amplifiers 
to be connected together and form a full rack-width unit. 

Mount two NetPA Ultra Series amplifiers by doing the following:

1.	 If the rubber feet are installed on the bottom of the amplifier, remove them.

2.	 Position two amplifiers upside down and next to each other.

3.	 Use the bridge plate connector and the four provided #4 machine screws to connect 
the two amplifiers together (see figure 3, 1).

4.	 Attach the two short rack ears to the amplifiers with the four provided #6 machine 
screws (2).

e

NetPA U 1004 SERIES

1
2

3
4

OVER TEMP

LIMITER/PROTECT

SIGNAL

POWER AMPLIFIERS

ee

e

NetPA U 1004 SERIES

1
2

3
4

OVER TEMP

LIMITER/PROTECT

SIGNAL

POWER AMPLIFIERS

Mounting
screws (4)

2

1

Net

Net

Figure 3.	 Installing NetPA Ultra Series Bridge Plate

5.	 Insert the amplifiers into the rack and align the holes in the rack ears with the holes in 
the rack.

6.	 Secure the amplifiers to the rack using the four provided 10-32 3/4” screws (see 
figure 4, 1 on the next page).

2  

3  
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e

NetPA U 1002 SERIES

1
2

OVERTEMP

LIMITER/PROTECT

SIGNAL

POWER AMPLIFIERS

ES

RS

e

NetPA U 1004 SERIES

1
2

3
4

OVERTEMP

LIMITER/PROTECT

SIGNAL

POWER AMPLIFIERS

NetPA ULTRA

NetPA ULTRA

1

Figure 4.	 Secure Connected NetPA Ultra Series to Rack

Rack Shelf Mounting
The NetPA Ultra Series can be mounted on a shelf using the optional RSU 129 1U Universal 
Rack Shelf Kit. 

Mount the amplifier with the shelf as follows:

1.	 If the rubber feet are installed on the bottom of the amplifier, remove them.

2.	 Place the amplifier on one half of the rack shelf.

3.	 Align the front of the amplifier with the front of the shelf, and align the threaded holes on 
the bottom of the amplifier with the holes in the rack shelf.

4.	 Attach the amplifier to the rack shelf with the two provided 4-40 x 3/16” machine 
screws. Insert the screws from the underside of the shelf and fasten them into 
diagonally-opposite corners.

ATTENTION:	
•	 Using screws longer than 3/16” damages the unit and voids the warranty.

•	 L’utilisation de vis plus longues que 3/16” endommagera l’unité et annulera 
la garantie.

(2) 4-40 x 3/16"
Screws

RSU 129
1U Universal Rack Shelf

False faceplate
uses 2 screws.

Use 2 mounting holes
on opposite corners.

e

  

1
2

3
4

OVERTEMP

LIMITER/PROTECT

SIGNAL

 

 

NetPA U 1004 SERIES

POWER AMPLIFIERS

NetP

Figure 5.	 Mounting the Amplifier onto a Rack Shelf

4  

5  
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5.	 Optional, attach a false front panel, not provided with the amplifier, to the unoccupied 
side of the rack, or install a second half rack-width device to that side.

Repeat steps 1 through 5 if a second device is being installed. 

6.	 Attach the shelf to the rack by using the four 10-32 x 3/4” screws provided with the 
shelf. Insert the screws through #10 beveled washers, then through the holes in the 
rack (see figure 5 on the previous page).

Rack Mounting Ventilation Recommendations
Excessive heat decreases the optimal lifetime of the power amplifier. An Over Temp 
indicator LED on the front panel of the amplifier lights red whenever the recommended 
operating temperature has been exceeded.

The NetPA Ultra amplifiers need to be arranged in a rack environment, so that the 
environment around the amplifier does not reach or go beyond +122°F (+50°C). No more 
than four amplifiers should be stacked one-on-top-of-the-other without an open space in 
between, as seen in figure 6.

The NetPA Ultra amplifiers can be arranged above or below another non-NetPA Ultra device. 
The environment around the amplifier should not reach or go beyond +122°F (+50°C).

Vent Space

Vent Space

Vent Space

Vent SpaceVent Space

Vent Space

Vent Space

Figure 6.	 Ventilation

6  
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Flexible Conduit Adapter Kit

 WARNING:

 AVERTISSEMENT : 

•	 The circuit breaker used for this connection should be rated no lower than 20 
amps and no greater than 30 amps.

•	 Le disjoncteur utilisé pour cette connexion devrait avoir une cote comprise entre 
20 et 30 amps.

•	 This unit must be installed in accordance with the National Electrical Code and 
with all local codes.

•	 Cet appareil doit être installé conformément au National Electrical Code et à tous 
les codes locaux.

•	 An ALL-POLE MAINS SWITCH with a contact separation of at least 3 mm in 
each pole shall be incorporated in the electrical installation of the building, The 
installation shall be carried out in accordance with all applicable installation rules.

•	 Un interrupteur omnipolaire avec une séparation contact d’au moins 3 
mm dans chaque pôle, devra être incorporée dans l’installation électrique du 
bâtiment. L’installation doit être réalisée conformément à toutes les règles 
d’installation applicables.

•	 Installation and service must be performed by a qualified electrician only.

•	 L’installation et l’entretien doivent être effectués uniquement par un électricien 
qualifié.

•	 Make sure the source device and the NetPA Ultra are turned off and 
disconnected from the power source before you begin.

•	 Vérifiez que l’appareil source et le périphérique source sont éteints et 
déconnectés de la source d’alimentation avant de commencer.

•	 To reduce the risk of fire or electric shock, do not expose this apparatus to rain or 
moisture.

•	 Afin de réduire les risques d’incendie ou de choc électrique, protégez cet appareil 
de la pluie ou de l’humidité.

•	 The product is a Class I product, which must be connected only to a mains 
socket outlet with a protective earthing (grounding) connection.

•	 Ce produit est un produit de Classe I, qui doit être connecté seulement à une 
prise femelle secteur équipée d’une connexion de mise à la terre.

•	 The mains plug/appliance coupler is used as the disconnect device and shall 
remain readily operable.

•	 La fiche secteur / le coupleur d’appareil est utilisé comme dispositif de 
déconnexion et doit rester facilement utilisable.

•	 A UL-Listed electrical distribution box is recommended for the termination of the 
conduit opposite the NetPA Ultra amplifier. See UL Requirements on the next 
page.

•	 Un boîtier de distribution électrique certifié UL est recommandé pour la 
terminaison du conduit à l’opposé de l’amplificateur NetPA Ultra. Voir UL 
Requirements.
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The optional Flexible Conduit Adapter Kit includes the following parts:

•	 One conduit adapter plate (pre-attached), for XPA 1002/2001 amplifiers

•	 One conduit adapter plate for XPA Ultra Series and NetPA Ultra Series amplifiers (not 
attached)

•	 One 6-foot long electrical conduit

•	 Three 7.5-foot 18-gauge power wires with spade connectors

•	 One UL rated zip tie wrap

•	 Three auxiliary crimp style spade connectors designed for 14- to 16-gauge wires

The kit provides a way to replace the IEC power cord with a conduit, where required by local 
codes.

NOTES:	

•	 If needed, Extron recommends using a UL-Listed crimp tool to terminate the 
spade connectors. One recommended choice is Molex crimp tool.

•	 The UL-Listed electrical distribution box is not included with the NetPA Ultra 
amplifier or the Flexible Conduit Adapter Kit. The installer is responsible for 
obtaining and installing the distribution box.

UL Requirements
The Underwriters Laboratories (UL) requirements listed below pertain to the installation of 
the flexible conduit onto an NetPA Ultra series power amplifier.

•	 This unit must not be used beyond its rated voltage range.

•	 This unit must be wired to a UL-Listed distribution box.

Installing the Flexible Conduit Adapter Kit

  WARNING:	 Electrostatic discharge (ESD) can damage IC chips even though you 
cannot feel it. You must be electrically grounded before touching anything inside the 
NetPA Ultra. A grounding wrist strap is recommended.

ATTENTION :	 Les décharges électrostatiques peuvent endommager les puces de 
circuit même si vous ne pouvez pas les sentir. Vous devez être électriquement relié à 
la terre avant de toucher un élément à l’intérieur du NetPA Ultra. Un braceletde mise 
à la terreest recommandé.

Install the flexible conduit to the NetPA Ultra Series amplifier as follows:

1.	 Unplug the IEC power cord from the amplifier.

2.	 Remove the eight screws from the top, sides, and bottom of the amplifier, then slide 
and lift the cover off (see figure 7 on page 13). 

step 2
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1
2

3
4

NetPA U 1004
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PUTS1

2
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SIGNAL

LINK

R

CLASS 2 W
IRING

2

1

4

3

Tx
Rx

RS-232

G
G

3
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1

2

3

4

100-240V      
1.0 A, 50-60Hz

LINE OUTPUTS

CONFIG

REMOTE

8Ω/4Ω OUTPUTS

A
T

Remove (8)
screws

Slide cover forward and
lift straight up.

Figure 7.	 Removing the Cover

3.	 Remove the two screws holding the blue hot (line) and the brown neutral wires from the 
terminal block on the PCB. Put the screws to the side to be used later (see figure 8).

4.	 Remove the ground wire nut from the grounding stud located on the bottom of the 
enclosure, as shown below. Place the wire nut with the other screws to be used later.

5.	 Remove the wires attached to the IEC connector from the body of the amplifier, and 
slide the IEC connector and attached wires up and out of the amplifier enclosure.
Disconnect cables
and remove IEC
connector.

Blue Wire

Brown Wire

Remove nut

Figure 8.	 Removing the IEC Connector

6.	 Remove the washer at the end of the conduit (see figure 9, washer-B), and remove the 
conduit adapter plate that ships attached to the conduit. 

Separate adapter plate
and washer from conduit

Washer-B

Washer-A

Conduit Adapter Plate

Figure 9.	 Removing the Existing Adapter Plate

7  

step 4

8  

9  
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7.	 Place the adapter plate that ships with the conduit kit on the conduit, with the flat side 
of the plate facing the hexgonal nut (washer-A), and secure the new plate to conduit 
with the washer that was removed back in step 6 (washer-B) (see figure 10).

Place the adapter plate
with the flat side against
washer-A and secure with
washer-B.Washer-B

Washer-A

NetPA Ultra Series Conduit
Adapter Plate

Figure 10.	 Secure NetPA Ultra Series Adapter Plate to Conduit

8.	 Thread the blue, brown, and green 18-gauge power wires that are included with the 
flexible conduit adapter kit through the length of the electrical conduit.

9.	 Install the conduit with the new conduit plate attached into the opening from where the 
IEC connector was removed in step 5 (see figure 11).

10.	Connect the blue hot (line) and the brown neutral wires to the terminal block on the 
PCB using the two screws removed back in step 3. Use the included zip tie wrap to 
secure the two wires together close to the terminals.

 WARNING:	 Ensure that you observe correct wire polarity. The following 
illustration shows the location of the hot (line) and neutral terminals.

AVERTISSEMENT : Respecter la polarité correcte des câble. L’illustration suivante 
indique l’emplacement des bornes de ligne et de neutre.

L N

Slide IEC
connector
plate and
conduit into
enclosue.

50-60Hz

100-240V     1.3A

Blue Wire

Brown Wire

Tie Wrap

Grounding Nut

111

222

1	 Blue wire — Hot Line

2	 Brown wire — Neutral

Figure 11.	 Install the Conduit Assembly

11.	Connect the ground wire, as shown in the figure above, to the grounding stud located 
on the bottom of the enclosure using the nut removed in step 4 on the previous page.

12.	Replace the cover of the NetPA Ultra amplifier by reattaching the eight screws removed 
in step 2 on page 11.

10  
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Operation 

This section describes the operation of the NetPA Ultra Series Amplifiers. Topics include:

•	 Front Panel Features	 •	 Standby modes

•	 Rear Panel Features	 •	 Hardware Reset Modes

•	 Operation

Front Panel Features

NetPA U 1002 SERIES

OVER
TEMP 2

LIMITER/PROTECT

SIGNAL

1

1 2 3

NetPA U 1004 SERIES

OVER
TEMP 2

LIMITER/PROTECT

SIGNAL

1 3 4

1 2 3

1	 Power/Standby Indicator 2	 Over Temp Indicator 3	 Channel Status LEDs

Figure 12.	 NetPA Ultra Series Front Panel 

NOTE:	 The front panels of all models in the NetPA Ultra Series function identically.

1	 Power/Standby LED — A single LED that lights green when the unit is on and active, 
and lights amber when:

•	 The unit is powering up and booting.

•	 The unit is in standby mode, which turns off all outputs from the amplifier although 
the amplifier still receives power.

•	 DC voltage is detected (see Troubleshooting on page 101).

•	 This LED unit flashes amber when an Identify Device request is sent to the unit 
via Dante Controller, and the Link Indicator LED located on the rear panel blinks 
green. Once the cycle has been completed, the LEDs return to normal.

NOTE:	 Power indicator LED may light amber for a short time after the removal 
of AC power. This is normal.

12  
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2	 Over Temp indicator (see figure 12 on the previous page) — A single LED that 
lights red when the amplifier has exceeded the maximum recommended operating 
temperature. The amplifier recovers once the unit has sufficiently cooled down (see 
Troubleshooting on page 101).

3	 Channel Status LEDs — Two rows of two LEDs on the NetPA U 1002 units or two 
rows of four LEDs on the NetPA U 1004 units that represent amplifier channels.

•	 Limiter/Protect LED — This LED lights red when the channel is in protection 
mode, which is triggered by any of the limiter protection circuits such as:

•	 When the channel is in an overload situation.

•	 When the output short circuits.

•	 When digital clipping is detected on the output of the DSP going into the 
amplifier channel.

•	 When the channel overheats.

•	 Signal LED — This LED lights green when the output signal from a DSP channel 
that goes to an amplifier channel crosses the DSP signal detection threshold. The 
threshold is -59 dBFS.

NOTE:	 The LEDs are also located on the rear panel.

Rear Panel Features
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1	 IEC power receptacle 2	 Mic/Line Inputs 3	 Channel Status indicators 

4	 Line Outputs 5	 Remote ports 6	 USB Config port

7	 Reset button with Reset mode LED 8	 Speaker Outputs 9	 AT port with Link LED

Figure 13.	 NetPA Ultra Series Amplifier Rear Panels

NOTE:	 The NetPA U 1004 and NetPA U 1002 rear panels are displayed above. The 
other rear panels in the NetPA Ultra Series amplifiers function identically.

Over Temp Indicator

Channel Status LEDs
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1	 IEC power receptacle — Connect a standard IEC AC power cord here for power 
input (100 VAC to 240 VAC, 50-60 Hz) to the internal, auto-switching power supply. 
This connector may be replaced by the Flexible Conduit Adapter Kit (see Flexible 
Conduit Adapter Kit on page 10).

2	 Mic/Line Inputs (see figure 13 on the previous page) — Connect up to four 3-pole 
3.5 mm captive screw ports to input up to four balanced or unbalanced line level or 
microphone level signals. 

NOTE: Inputs remain active during standby. Phantom power is not available on any of 
the inputs (see figure 14 for captive screw connector wiring).

Balanced Input Unbalanced Input Do not tin 
the wires!

Tip

Sleeve
Ring

Tip

Sleeve
Jumper

Figure 14.	 Captive Screw Connector Wiring

3	 Channel Status indicators (see figure 13) — Two double-stacked LEDs on the 
NetPA U 1002 units and four double-stacked LEDs on the NetPA U 1004 units. The top 
red LEDs are used for Limiter/Protect status, and the bottom green LEDs are for signal 
status.

The LEDs function the same as the LEDs on the front panel.

4	 Line Outputs (see figure 13) — Connect up to two or four 3-pole 3 mm captive screw 
connectors in order to output up to two or four balanced or unbalanced line level output 
signals. 

NOTE:	 The outputs do not remain active when the amplifier is in standby. For 
applications where the line and Dante outputs may be used independently during 
long periods of no amplifier activity, such as when the unit is being used as both 
an amplifier and off/on-ramp to the Dante network, the auto-standby timer must 
be disabled and the amplifier must not be forced into standby. 

Balanced Mono Output Unbalanced Mono Output Do not tin 
the wires!

Tip

Sleeve
Ring

Tip

Sleeve
No Ground here

CAUTION:	 For unbalanced autio outputs, connect the sleeves to the ground 
contact. DO NOT connect the sleeves to the negative (-) contacts.

Figure 15.	 Captive Screw Connector Wiring

5	 Remote ports (see figure 13) — Connect a 3.5 mm 3-pole captive screw connector 
to the RS-232 port to remotely monitor and control the unit. Connect a 3.5 mm 2-pole 
captive screw connector to the standby port to remotely place the amplifier in standby 
mode (see figure 16 on the next page)).

Standby mode is activated when the Standby pin is connected to the G pin. Standby 
mode turns off all the outputs, although the amplifier still receives power. The power 
LED on the front panel lights amber when the amplifier is in standby mode. 

The amplifier enters standby mode when one of the following happens and are 
prioritized as follows:

•	 Activation of the remote standby port (done by shorting the STANDBY pin to the 
ground pin).

•	 Through the PSAV (Standby) (see page 104) or through DSP Configurator 
(accessed via Tools > Configure Standby Settings).

14  
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•	 After 25-minutes of inactivity.

NOTE:	 The inactivity timer can be disabled, and the STANDBY pin and SIS 
Command can continue to force the unit into Standby mode (see Force 
standby on on page 91 in the SIS Command section to learn how to force 
standby mode).

S
T

A
N

D
B

Y
G

R
E

M
O

T
EDo not tin 

the wires!

Tx
Rx

G

G
STANDBY

T
x

R
x

G

R
S

-232

Figure 16.	 Captive Screw Connector Wiring

6	 USB CONFIG port (see figure 13 on page 15) — Connect a mini USB type B 
connector between this port and a computer for local configuration, and montoring the 
amplifier.

7	 Reset button with Reset Mode LED — Press this recessed button (R) to reset the 
amplifier. There are various reset modes. The reset LED indicates which reset mode has 
been accessed. 

•	 Mode 1 — Hold the Reset button (R) while applying power to restore the unit 
firmware back to the default factory firmware. This recovers a unit that has incorrect 
code or updated firmware running. All user settings are maintained.

•	 Mode 2 — Press the rear panel Reset button and quickly release it to cause a 
hardware reboot of the Dante module while preserving all of its settings such as IP 
configuration, routing, device name, channel names, and sampling rate.

•	 Mode 3 — To cause an absolute system reset of the Dante module back to factory 
default conditions:

With power on, press and hold the reset button for about 3 seconds until the reset 
LED blinks one time (once at 3 seconds), then release and within  second press 
Reset button (R) momentarily (< 1 second). 

Following this reset, the Dante module proceeds to its normal boot sequence. This 
reset:

•	 Restores the IP Configuration to default settings.

•	 Clears all Dante audio channel routing.

•	 Sets the Dante device name and channel names to default.

•	 Mode 5 — With power on, press and hold the reset button for about 9 seconds 
until the reset LED blinks three times (once at 3 seconds, again at 6 seconds, again 
at 9 seconds), then release and press Reset momentarily (< 1 second). 

Mode 5 resets the device settings while preserving Dante specific settings such as 
IP configuration, routing, device name, channel names, and sampling rate. 

This reset:

a.	 Sets mix-points to unity gain (0 dBFS) and the following connections are made.

•	 AT input 1 is routed to amp output 1

•	 AT input 2 is routed to amp output 2

•	 AT input 3 is routed to amp output 3

•	 AT input 4 is routed to amp output 4

•	 AT input 1 is routed to line output 1

•	 AT input 2 is routed to line output 2

•	 AT input 3 is routed to line output 3

•	 AT input 4 is routed to line output 4

b.	 Unmutes amp outputs and sets them to -24 dB.

c.	 Unmutes line outputs/AT outputs and sets them to unity gain.

16  



 

NetPA Ultra Series • Operation 18

d.	 Sets trim blocks to unity gain.

e.	 Unmutes gain blocks and sets them to unity gain.

f.	 Removes any inserted or active DSP.

g.	 Unmutes all inputs and sets them to unity gain.

h.	 Clears all preset and group master memory.

i.	 Turns off unsolicited responses for status updates.

j.	 Enables standby timer. 

k.	 Ensures unit will not be in standby mode.

The Reset LED flashes 3 times in quick succession during the reset.

8	 Speaker Outputs (see figure 13 on page 15) — Connect up to two 4-pin, 5 mm captive 
screw connectors for up to four channels of speaker output. Each port has a screw flange to 
secure the plug to the connector. Observe the correct polarities for each channel as shown below.

1 2

   

   

 

3 4
CLASS 2 WIRING

      8Ω/4Ω OUTPUTS

 WARNING:

AVERTISSEMENT : 

•	 Do not tie channel output pins to each other or to ground. Doing so will short 
out the outputs, damage the amplifier, or both. 

•	 Ne pas lier les sorties 1 et 2 des canaux entre elles ou à la terre. Les sorties 
pourraient être court-circuitées et/ou l’amplificateur pourrait être endommagé

•	 To avoid risk of damage to the amplifier or the speakers, always connect 
low‑impedance speaker loads (8 Ω / 4 Ω ) and high-impedance speaker loads 
(70 V) to the appropriately marked output connectors on the amplifier.

•	 Pour éviter tout risque de détérioration de l’amplificateur ou des enceintes, 
connectez toujours les charges de l’enceinte faible impédance (8 Ω/ 4 Ω) et 
les charges de l’enceinte haute impédance (70 V) aux connecteurs de sortie 
correctement identifiés sur l’amplificateur.

NOTE:	 You must use Class 2 wiring for this output to comply with UL requirements.

To wire the stereo audio output, do the following:

1.	 Strip and insert the speaker wires into the connector and tighten the captive 
screws. 

Make sure to observe correct polarity.

Do not tin the wires!

Figure 17.	 Securing Speakers Wire with Captive Screws
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2.	 Insert the wired connector into the amplifier output, and secure the plug by 
tightening the screws on either side (see figure 18).

 

CLASS 2 W
IRING

 / 
 OUTPUTS

1

2

Figure 18.	 Securing Speaker Connector to Amplifier with Screw Locks

9	 AT port with Link LED (see figure 13 on page 15) — Connect one RJ-45 connector 
to communicate with a Dante network. The port uses the Dante protocol, but can be 
configured for the AES 67 standard in Dante controller. It is one of the ways the amplifier 
communicates with DSP Configurator.

•	 The Link LED is locked to the Dante sync signal.

•	 The LED has three states in normal operation:

•	 Blinking (1 Hz) Green: The Dante module generates network audio clock. The 
unit is the master clock

•	 Lit Solid Green: The Dante module locked to network audio clock. The unit is 
synchronized to network audio clock.

•	 Off: The Dante module not locked to network audio clock. 

Go to AT Port on page 20 for more details on this port.

Operation
The section below details some of the NetPA Ultra Series amplifiers features.

Default
The following are the NetPA Ultra Series Amplifier defaults right out of the box:

•	 All mix-points and trim blocks are set to 
unity gain.

•	 All preset and group master memory is 
clear.

•	 All line outputs, gain blocks, and inputs 
are unmuted and set to unity gain.

•	 Standby timer is enabled and unit is not 
in standby.

•	 Attenuation blocks are set to -24 dB for 
amplified outputs

•	 Unsolicited response status monitoring 
is disabled.

•	 Routing — AT Inputs are routed to their respective amp and line outputs (for example, 
AT Input 1 routed to amp output 1 and line output 1.)

NOTE:	 The attenuation blocks of the amplifier outputs are set to -24 dB in order to 
prevent an excessive amount of signal from being passed to the speaker before the 
amplifier can be properly configured.

18  
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AT Port
The NetPA U 1004 supports four AT inputs, as well as four AT outputs (which are shared 
with the analog line outputs), while the NetPA U 1002 only supports 2 AT inputs and 2 AT 
outputs (these are not shared with the analog line outputs). Audio coming in from the  
mic/line inputs can be placed onto the Dante network, and the AT outputs can be 
received by any other device as long as it is using the Dante protocol. The port supports 
bi‑directional channels of 24 bit/48 kHz digital audio. 

NOTE:	 The AT port can be set to 44.1 kHz, 48 kHz, 88.2 kHz, or 96 kHz, however the 
signal going through the DSP is converted to and processed at 48 kHz.

The AT port allows latency to be set per device at either 1.0 ms, 2.0 ms, or 5.0 ms.

Dante Controller provides control and configuration to the entries listed below. However, 
Dante Controller is not limited to the entries.

•	 Dante channel routing

•	 Dante channel naming

•	 Dante reboot

•	 Device naming

•	 Setting network master clock

•	 Get network and device Dante status

•	 Set DHCP mode and device IP address 

•	 Setting sample rate to one of the 
following frequencies:

•	 44.1 kHz 	 •	 88.2 kHz

•	 48 kHz	 •	 96 kHz

NOTES:	

•	 For applications where the line and Dante outputs may be used independently 
during long periods of no amplifier activity, such as when the unit is being used as 
both an amplifier and off/on-ramp to the Dante network, the auto-standby timer 
must be disabled and the amp must not be forced into standby mode. 

•	 On NetPA U 1004 models, selecting 88.2 kHz or 96 kHz sample rates disables 
the transmit channels.

Standby modes
The amplifier may be placed into 3 standby modes through SIS, DSP Configurator or 
a control system. The amplifier may also be forced into standby through the rear panel 
contact closure.

To change the Standby settings via DSP Configurator:

Navigate to the Tools menu and select Configure Standby Settings, then make your 
selection to change the settings (see figure 19 on the next page).

Standby modes
•	 Mode 0

•	 Mode 1

•	 Mode 2

= 

= 

= 

Disable Auto-Standby Timer 

Enable Auto-Standby Timer 

Force Standby mode
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Figure 19.	 Configuring Standby Settings with DSP Configurator

Standby Selection (via SIS or Control System):

•	 Mode 0:	 When the amplifier is in Standby mode 0, the Auto-Standby Timer is disabled 
and the amplifier does NOT automatically enter standby mode when no active signal is 
present on any amp channel for 25 minutes.

•	 Mode 1:	 When the amplifier is in Standby mode 1 (default), the Auto-Standby Timer is 
enabled. The amplifier remains active while there is an active signal on any amp channel. 
The amplifier enters standby mode if no active signal is present on any amp channel for 
25 minutes. It returns to active upon detection of signal on any amp channel. When the 
SIS command is sent, the timer resets and the amplifier goes into power save state 1. 

•	 Mode 2:	 When the amplifier is forced into Standby mode 2 via SIS, DSP Configurator, 
or a control system, the unit remains in standby until the amplifier is placed into Standby 
mode 0 or 1 the same way, regardless of signal presence.

•	 Mode 3 (not accessible via DSP Configurator or SIS):	 This mode occurs when the 
amplifier begins in Mode 1 and there is no active signal present on any amp channel for  
25 minutes. In this mode the amplifier is in standby and can be taken out of standby via 
an active signal on any amp channel, DSP Configurator, or SIS.

•	 Mode 4 (not accessible via DSP Configurator or SIS):   When the amplifier is forced 
into standby via the STANDBY port (contact closure), it remains in this state until the 
contact is opened. Once opened, the amplifier returns to its last known standby state. 
This function overrides all other standby conditions.

NOTES:	
•	 In Standby mode, the line and Dante outputs are muted.

•	 The auto-standby function relies on active signals that are routed to the amplified 
outputs.  Signals that are routed only to the line or Dante outputs, but not the 
amplifier outputs, do not prevent the unit from going into auto-standby due to 
inactivity.  

•	 For applications where the line and Dante outputs may be used independently 
during long periods of no amplifier activity, such as when the unit is being used as 
both an amplifier and off/on-ramp to the Dante network, the auto-standby timer 
must be disabled, and the amplifier must not be forced into Standby mode.
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Bridging (8 ohm/4 ohm outputs only)
NOTE:	 During bridged mono output, the + output from the odd channel becomes the 

positive terminal and the + output from the even channel becomes negative.

The output power to a speaker can be doubled by bridging the output.

NOTE:	 Bridging is only available on the NetPA U 1002/1004 low-impedance models. 
The minimum load impedance when bridging is 8 ohms.

To bridge the output, follow the steps and refer to the following diagrams:

1.	 Connect the IEC power cord and power up the amplifier.

Do not plug in any inputs yet.

2.	 Configure the amplifier.

a.	 Determine the amplified output pair that is used for bridging: 1&2 (NetPA U 1002 or 
1004) or 3&4 (NetPA U 1004 only).

b.	 Determine the input or inputs feeding the output.

c.	 Route the input or inputs to both outputs.

The gain and mute should be the same for each mix point from each input to each 
output.

 

Figure 20.	 Matching Gain and Mute

d.	 Configure the amplified output pair. Each channel of the output pair must be 
configured similarly 

i.	 Configure the trim, delay, filter, dynamics, and attenuator block for the odd 
channel.

.

Figure 21.	 Accessing Amplifier Output Block Panel

ii.	 Copy and paste the configuration of the odd channel to the even channel.

iii.	 Open the attenuator block of the even channel and click the polarity box to 
invert the signal (see figure 22 on the next page). The sign on the box should 
change from ‘+’ to ‘-‘ and its color should change to yellow.
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Figure 22.	 Attenuation Blocks

iv.	 Create groups for the trim and attenuation blocks of the two channels to control 
gain and mute of both channels simultaneously.

Figure 23.	 Gain Controls

NOTES:	
•	 Set the attenuator of the attenuation blocks (via the created group) to 

-24 dB or lower to prevent an unexpectedly loud signal from getting to 
the speaker when you first test the system (see figure 22).

•	 For details on each processing block see DSP Configurator Software 
on page 28.

e.	 Verify that the gain structure through the signal chain is set appropriately, especially 
that the mix points are set to the same gain and mute values.

f.	 If using Dante inputs, make the ties as shown in Dante Controller (see 
page 75).

3.	 Unplug the IEC power cord from the amplifier.

4.	 Wire the outputs (see figure 24 on the next page).
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ATTENUATION
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Figure 24.	 Bridging the Output

NOTE:	 During bridged mono output, the + output from the odd channel becomes 
the positive terminal and the + output from the even channel becomes the 
negative terminal.

5.	 If needed, wire the inputs as shown in figure 24. If only using Dante inputs, skip this 
step.

6.	 Connect the IEC power cord and power up the amplifier.

7.	 Verify the configuration by testing the system.

Monitoring
There are two methods to monitor the amplifier, querying and unsolicited responses. Either 
method or a combination of the two can be employed.

NOTES:	
•	 All status flags reset upon power cycle. Status flags can also be reset via SIS (see  

Resets on page 94).

•	 See Status on page 95 of the SIS section and Troubleshooting on 
page 101 for detailed descriptions of each status.

Querying

•	 In the SIS section, see Status on page 95 for the commands to query.

•	 Each status command is capable of being queried.

•	 Query commands can be used when polling with a control system.

•	 All statuses can be queried, even when unsolicited responses are enabled.
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Unsolicited responses

NOTE:	 Unsolicited responses are turned off by default to reduce unnecessary network 
traffic, and must be turned on if needed.

1.	 Set the unit to verbose mode 2 or 3.

2.	 Use the NTFY command (see Status on page 95) to configure.

a.	 E M X!*X@ NTFY}

X! = xxxx
Signal Presence

Overload

Digital ClippingGeneral

•	 Where x = 1 (on) or 0 (off [Default]).

•	 Determines which unsolicited responses get turned on.

NOTE:	 Some responses may not be desired or may report too frequently, 
requiring them to be disabled.

b.	 X@ = 

0 = All (Default)

1 = Dante Port

2 = RS-232

3 = USB

•	 This variable specifies which port to direct the responses.

•	 This is useful when you need to keep traffic to a minimum on a particular port 
or ports.

3.	 When listening over the Dante port, a DMP Plus Series device is needed to facilitate 
communication between the amplifier and control system.

The DMP can be set to pass through SIS commands to connected Dante controlled 
Extron devices.

To send an SIS command to the amplifier connected to a DMP:

a.	 Connect the DMP and Dante controlled devices to the same network via their AT 
ports.

b.	 Connect to the DMP via the DataViewer or HyperTerminal utility. 

c.	 Use the Set verbose mode command to set the DMP to Verbose mode 3 (see 
Verbose Modes on page 86).

Example: 

Command Response

w3cv| Vrb3]

d.	 Use the Query available remote devices command to receive a list of Dante devices 
that are currently connected to the DMP. 

Example: 

Command Response
waexpr| ExprA•NetPA-U-xxxxxx]

AXI-XTP-RoomB]]

NOTE:	 This list is similar to the list displayed within Dante Controller.
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e.	 Use the Enable remote connection for listening command to display the remote 
Dante controlled device responses based on the list of devices provided in the 
response in step d. Repeat if necessary for all desired devices. 

Example:

Command Response

wcNetPA-U-xxxxxx*1expr| ExprNetPA-U-xxxxxx*1]

NOTE:	 Devices can be set up for listening even if not currently connected to 
the DMP unit.

f.	 To verify that the DMP is listening to the correct remote devices, use the Query 
remote devices being listened to command to display a list of all remote devices 
enabled with the command in step 5. 

Example:

Command Response

wlexpr| ExprL•NetPA-U-xxxxxx]

g.	 Send the desired command to the amplifier and confirm the correct response is 
received. 

•	 When entering a command, use the “w” character in place of the <Esc> key 
and the “pipe” character ( | ) in place of a carriage-return. Failing to do so may 
cause the command to fail.

•	 The closing bracket ( } ) is necessary to successfully end a command before 
attempting to send a new command. 

Example:

Command Response

{dante@NetPA-U-
xxxxxx:wg40000*-
10AU|}}

{dante@NetPA-U-xxxxxx}DsG40000*-
10]

NOTE:	 The DMP provides the tag showing the Dante controlled remote device 
name while the remote device provides the response for the SIS command. 
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Hardware Reset Modes

ATTENTION:	 The reset modes listed below will close all open IP and Telnet 
connections, and close all sockets.

MODE 1: Hold the reset button (R) while applying power to restore the unit firmware back to the default factory firmware. This recovers a 
unit that has incorrect code or updated firmware running. All user files and settings are maintained.

MODE 2: Press the rear panel reset button and quickly release it to cause a hardware reset of the Dante module while preserving all of its 
settings such as IP configuration, routing, device name, channel names, and sampling rate.

MODE 3: To cause an absolute system rest of the Dante module back to factory default conditions, press and hold the rear panel reset 
button for 15 seconds until the AT (PoE) port LEDs flash. Following this reset, the Dante module will proceed to its normal boot 
sequence. This reset will:

•	 Set the IP configuration to default settings	  • 	 Clear all audio channel routing

•	 Set the Dante device name and channel names to default

MODE 5: With power on, press and hold the reset button for about 9 seconds until the Power LED blinks three times (once at 3 seconds, 

again at 6 seconds, again at 9 seconds,), then release and within 1 second press  reset button (R) momentarily (<1 second).

Mode 5 performs a complete reset to factory defaults, except for firmware and Dante:

•	 Mix-points are set to unit gain (0 dBFS)  

•	 AT input 1 is routed to amp output 1	 AT input 1 is routed to line output 1

•	 AT input 2 is routed to amp output 2	 AT input 2 is routed to line output 2

•	 AT input 3 is routed to amp output 3	 AT input 3 is routed to line output 3

•	 AT input 4 is routed to amp output 4	 AT input 4 is routed to line output 4

•	 Amp outputs are unmuted and set to -24 dB

•	 Line outputs are unmuted and set to unity gain

•	 Trim blocks will be set to unity gain.

•	 Gain blocks will be unmuted and set to unity gain

•	 Any inserted or active DSP is removed 

•	 All inputs are set to unity gain and are unmuted

•	 All preset and group master memory is cleared

•	 Status monitoring unsolicited repsonses will be turned off

•	 Standby timer will be enabled

•	 Unit will not be in standby

•	 The  Reset button (R) LED flashes 3 times in quick succession during the reset.
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DSP Configurator 
Software

Extron DSP Configurator Software is the main user interface for control and management of 
an Extron NetPA Ultra Series power amplifier and all of its audio functions, including mixing, 
gain, dynamics, filtering, delay, microphone ducking, and monitoring. This section describes 
the Extron DSP Configurator software and covers the following topics:

•	 Downloading and Installing DSP Configurator •	 DSP Configurator Inputs

•	 Accessing the DSP Configurator Help File •	 DSP Configurator Outputs

•	 DSP Configurator Main Workspace •	 Monitoring

Downloading and Installing DSP Configurator
1.	 On www.extron.com, hover over the Download tab at the top of the page.

2.	 From the Feature Software list, select DSP Configurator Software.

3.	 From the DSP Configurator Software product page, click the blue Download button.

4.	 Select Run to run the DSP Configurator installer. 

or

Select Save to save the install file to run at a later time.

5.	 To run DSP Configurator from the default install location, click Start > Programs > Extron > 
DSP Configurator > DSP Configurator.

6.	 From the DSP Configurator splash screen drop-down list (see figure 25, 1), select the NetPA 
Ultra Series model that is connected to the host PC and click OK (2). 

1
2

Figure 25.	 DSP Configurator Splash Screen 
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Accessing the DSP Configurator Help File
DSP Configurator comes loaded with a context-sensitive help file, which can be accessed by clicking 
the Help icon (see the icon to the right) in the top right corner. The Help icon (  ) is always in the 
top right corner of any dialog box in DSP Configurator. There are other options to accessing the help 
file: click Help > Contents in the menu bar at the top of the main workspace, or press F1.

The help file contains detailed procedures and further instructions on all of the 
DSP Configurator features.

DSP Configurator Main Workspace
The DSP Configurator main workspace can be divided into four main sections (see 
figure 26). Each section contains various functions to configure the NetPA Ultra Series 
amplifiers. Use the expand and collapse button, next to the input and output group names 
to show or hide the groups and their corresponding mix matrices. If necessary, scroll 
through the window by using the mouse wheel or the scroll bar at the right side of the 
DSP Configurator main workspace.

        

1	 Menu Bar 2	 Mic/Line Inputs 3	 Mix-Points 4	 Outputs

Figure 26.	 DSP Configurator Main Workspace

Menu Bar

File

The File menu offers the standard Windows File Menu options such as New, Open, Save, 
Save As, Recent Files, and Exit, along with three operations that are specific to Extron 
devices. Those operations are:

NOTE:	 Configuration files have a .EDC file extension and template files have a .EDCT 
file extension 

•	 Export Single Device — Saves the selected device in Device Manager as a 
configuration file. This function is used to save an individual device when there are 
multiple devices listed in the Device Manager (see page 68).

•	 Backup — Recalls and transfers all partial presets of a NetPA Ultra amplifier to the 
configuration file or template file within DSP Configurator.

•	 Convert Device to... — Select NetPA unit to which the current configuration file is 
converted. After a conversion target model is selected, the Device Conversion dialog 
opens. For more information, refer to the DSP Configurator Help File by clicking the 
context sensitive help (?) button in the dialog.
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Edit

The Edit menu offers the standard Windows Edit Menu options such as Cut, Copy, and 
Paste.	

View

•	 Meter Bridge — Opens a meter bridge to view input and output activity. The meter 
bridge is a floating window that allows the use of DSP Configurator while simultaneously 
monitoring input and output activity.

NOTE:	 The meter bridge is only available in Live mode with a TCP/IP connection.

•	 Re-enable All Dialogs — This option re-enables all dialog boxes to no longer appear 
based on user selection (certain dialog boxes appear as user-defeatable by selecting a 
checkbox that reads Do Not Show This Dialog Again).	

•	 Group Controls — Opens the Group Controls dialog box to access existing group 
controls and add new groups.

•	 Show All Channels — Individual channels can be hidden by user selection. This 
provides options for the user to select which input and output groups are visible in the 
main workspace.

Tools

•	 Presets — Contains a submenu to mark and clear elements in the main workspace as 
well as an option to save marked elements to a preset (see Presets on page 63).

•	 Configure Groups — Opens the Configure Groups dialog box to create, edit, and 
delete Gain and Mute groups (see Configuring Groups on page 66).

•	 Configure Standby Settings — Opens a submenu to disable or enable the auto-
standby timer or force standby mode.

•	 Connect/Disconnect from Device — When in Emulate mode, this reads as 
Connect to Device and opens the Connect to Device dialog box (see Connect/
Disconnect from Device on page 70). When in Live mode, this reads Disconnect 
from Device and returns software to Emulate mode.

•	 Device Manager — Opens the Device Manager dialog box (see Device Manager on 
page 68).

•	 Issue RESET Command — Clears the amplifier of all processors and other 
configuration settings. This command does not reset general settings such as IP 
address.

•	 Firmware Loader — Opens the Firmware Loader application, if it is installed (see 
Firmware Loader on page 70). Visit www.extron.com to download the software.

•	 Organize Building Blocks — Opens the Organize Building Blocks dialog box (see 
Organize Building Blocks on page 71).

•	 Device Settings — Opens the Device Settings dialog box to edit date and time, IP 
address, DHCP status, and other settings (see Device Settings on page 72).

•	 Options — Opens the Options dialog box to configure DSP Configurator appearance, 
default settings, DSP value defaults, and so on (see Options on page 74).

•	 Network Audio Control — Opens the Dante Controller application by Audinate for 
routing audio over a Dante network (see Dante Controller on page 75).	

http://www.extron.com
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Window

The Window menu offers the standard Windows Window Menu options such as Cascade 
and Close All Windows.

Help

The Help menu offers the standard Windows Help Menu options such as Content, 
Search, and About. The help file can be accessed by clicking Content.

Presets Drop-Down List
The Presets drop‑down list allows the user to view and apply presets saved in the current 
configuration file or on a device connected in Live mode. Presets with an asterisk next to 
them are on the amplifier, but not in the current configuration file. Run a preset to load it into 
the configuration file. Alternatively, perform a backup to run all presets and load them into 
the current configuration file (see File on page 29).

Figure 27.	 Presets Drop-Down List

After selecting a preset from the list, choose one of the following actions from the 
DSP Configurator status panel:

•	 Recall — Recalls the selected preset and applies settings to the main workspace.

•	 Cancel — Cancels the preset recall and returns to the main workspace with the current 
emulation or state intact.

•	 Delete — Deletes the selected preset from the configuration.

Figure 28.	 Preset and Action Selection

DSP Configurator Status Panel
This panel displays the current status of DSP Configurator      
and shows when data is being pushed to or pulled from  
the device. When the software is ready to perform actions,  
the panel reads Ready.

Live and Emulate Panel
The Live and Emulate buttons allow users to switch 	  
between Live and Emulate mode. This panel also displays  
transmit activity (Tx) and receive activity (Rx) when in Live  
mode.

Emulate Mode

While in Emulate mode, DSP Configurator is functioning in an “offline” state. Changes made 
to the configuration file are not applied to a device.
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In Emulate mode, the user can create and configure the software as though a device was 
connected, except for any actions that require direct connection to the device or information 
that is stored only on the device. Once configuration is complete, the user can switch to 
Live mode and apply the configuration to the device or save the configuration file to be 
loaded onto one or multiple devices at a later time.

Creating configuration files in Emulate mode saves time by not requiring a device to be 
connected or present in order for the bulk of DSP configuration to be completed.

NOTE:	 Not all menu options or actions are available in Emulate mode.

Live Mode

Enter Live mode to connect to a NetPA Ultra Series amplifier and push or pull 
configurations between the device and host PC. In Live mode, changes made in 
DSP Configurator are directly applied to the NetPA Ultra Series amplifier. Additionally, 
presets can be created and stored on the device.

When entering Live mode, the user is prompted with the Connect to device dialog box.

Connect to a NetPA Ultra Series Amplifier in Live Mode
1.	 Click the Live button in the menu bar of the DSP Configurator. 

Alternatively, select Tools > Connect to Device or press <F6> on the keyboard. 

The Connect to device... dialog box opens (see figure 7).

2.	 Connect to the NetPA Ultra Series Amplifier. 

To connect via USB: 

•	 Click the USB tab in the dialog box (see figure 29, A). 

•	 Select the device from the USB Devices drop‑down list (B).

To connect via RS-232: 

•	 Click the RS-232 tab in the dialog box. Select the Com port the device is 
connected to on the host PC from the Com Port drop-down list (C), and then 
select the correct Baud Rate, Parity Bit, Data Bit, and Stop Bit.

To connect via Dante: 

•	 Click the Dante tab in the dialog box. Select the Ethernet port the device is 
connected to on the host PC from the Network Adapters drop-down list (C).

AAA BBB

Figure 29.	 Connect to device... Dialog Boxes
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3.	 When a connection with a device is established, the Synchronize with Device dialog 
box opens (see figure 30).

Figure 30.	 Synchronize with Device Dialog Box

1	 Pull — Pulls the configuration file and preset configurations from the device and 
displays it in the DSP Configurator main workspace.

2	 Push — Pushes the configuration file and preset configurations open in 
DSP Configurator to the connected NetPA U Series amplifier. The check boxes 
indicate what is pushed when OK is selected. Pushing a selected item overwrites 
that item on the device.

NOTE: If only pushing selected presets, the preset selection dialog box opens 
after clicking OK, allowing you to select which preset to push to the device.

If only pushing selected presets, mark them from the dialog box shown in figure 31.

Figure 31.	 Preset Selection Dialog Box

4.	 Once a push or pull is completed, the current state of the connected amplifier is 
displayed in the DSP Configurator status panel and the device is ready for further 
configuration.
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Exit Live Mode and Enter Emulate Mode
1.	 Click the Emulate button in the DSP Configurator 	  

menu bar (see the image on the right, 1).  
Alternatively, select Tools > Disconnect from  
Device or press <F6> on the keyboard.

2.	 Click OK to confirm.

Figure 32.	 Confirm Disconnect

DSP Configurator Inputs
All available inputs are listed vertically along the left side of the DSP Configurator main 
workspace. The input groups can be expanded or collapsed by clicking the  (expand) or  
(collapse) buttons next to the input group names.

There are two types of inputs available:

•	 Mic/Line Inputs •	 AT Inputs

Mic/Line Inputs
The four mic/line input channels in the NetPA Ultra Series amplifier are shown in 
DSP Configurator under the Inputs panel.

Figure 33.	 Inputs Panel

Inputs 1 - 4 can receive mic level or line level signals.

Naming an Input Channel

1.	 Click the input name field.	

2.	 Highlight or delete the text and enter a new name.	  

3.	 Press <Enter> or navigate away from the field to confirm and	  
apply the new input name. 

Press <Down Arrow> key to navigate to and highlight the next  
name field.

NOTE:	 Follow the same procedure to edit an input name.
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Input Building Blocks

Extron building blocks are a quick configuration tool that can significantly reduce 
configuration time. An input building block is a collection of processor and gain settings for 
an input processing chain. These building blocks have been designed by Extron based on 
extensive use and testing with each intended application or specific device.

Figure 34.	 Accessing Input Building Blocks

Click the input number (see figure 33 on the previous page) to open the Building Blocks 
dialog box.

1	 Building Block Folders

2	 General Building Blocks

3	 Add a Building Block Button

4	 Delete a Building Block Button

5	 New Folder Button

6	 Building Blocks Help Button

Figure 35.	 Input Building Blocks Dialog Box

1	 Building Block Folders — These folders group input types together, such as table or 
handheld mics, for easy access (see figure 36).

Figure 36.	 Mic Building Block Folder Contents

2	 General Building Blocks — These building blocks provide quick setup for input 
sources. General building blocks provide a useful starting point for devices in the same 
product category as the name of the building block, such as handheld microphones, 
line level sources, and so on.

3	 Add a Building Block Button — Creates a custom building block from the current 
gain and processor settings on the selected channel. 

When this button is clicked, the Add a Building Block dialog box opens. Name the 
new custom building block and choose a folder to save the block to, or create a new 
folder (see figure 37 on the next page).
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Figure 37.	 Add a Building Block Dialog Box

4	 Delete a Building Block Button (see figure 35 on the previous page) — Deletes 
the currently selected building block or building block folder. If default building blocks 
are deleted, they can be restored from the Organize Building Blocks dialog box. 
Custom building blocks can be saved to a file from the same dialog box (see Organize 
Building Blocks on page 71).

5	 New Folder Button — Creates a new folder or sub-folder in the Building Blocks 
dialog box.

6	 Building Blocks Help Button — Opens the Building Blocks topic of the 
DSP Configurator Help File. This topic contains more information on the different types 
of building blocks for inputs and outputs.

Mic/Line Inputs Processing
The mic/line input processing chain in DSP Configurator is visually represented by a string 
of blocks (see figure 38). Each block contains a specific processor or type of processor. For 
example, the Input Gain block contains a fader to boost or attenuate incoming signal, the 
Filter block contains several types of filters, and so on. Inputs 1 - 4 contain the following 
signal chain:

•	 Input Gain Block

•	 Input Filter Block

•	 Input Dynamics Blocks

•	 Input Ducking Block

•	 Input Pre-Mixer Gain Block

Figure 38.	 Input Processing Chain
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Input Gain Block

Double‑click the Input Gain block (as seen to the right) to open the 	  
Input Gain dialog box.

The Input Gain dialog box provides controls to configure the input	  
gain stage of the input processing path.

1	 Input Name — This name changes to match the default or user 	

1

2

3

4
5 6

7

8 9

¢
 

defined input name.

2	 Gain Fader — Provides up to 60 dB of gain or 18 dB of  
attenuation. 

•	 Click the fader once and press the <Up Arrow> or  
<Down Arrow> keys to adjust  the fader up or down in 1 dB  
steps. 

•	 Press the <Page Up> or <Page Down> keys to adjust  
the fader up or down in 10 dB steps.

3	 dBFS Meter — This meter displays the input signal level in dBFS  
ranging from -60 dBFS to 0 dBFS. Once the signal reaches or  
passes -1 dBFS (default) or the clip threshold defined in the  
Options dialog box (see Options on page 74), the clip box  
located at the top of the meter lights red.

4	 dBFS Numeric Readout — This read‑only text box displays the 
numerical value of the input signal level in dBFS.

5	 Input Gain Text Field — This text field allows the user to enter a gain or attenuation 
value in 0.1 dB steps.

6	 Polarity Toggle Button — Inverts the signal polarity of the selected input. When the 
button displays the black + symbol on a gray field ( ), the polarity is normal. When the 
button displays the black - symbol on a yellow field ( ), the polarity is inverted.

7	 Mute Button — Mutes signal at the input stage, preventing it from going any further in 
the signal processing chain.

8	 OK Button — Confirms changes and closes the Input Gain dialog box.

9	 Cancel Button — Reverts any changes made to the contained parameters back to 
their states when the current instance of the Input Gain dialog box was opened and 
closes the dialog box.

¢	 Input Gain Help Button — Opens the Mic/Line Input Gain topic in the 
DSP Configurator Help file for further assistance in configuring input gain.

Input Filter Block

Double‑click the Filter block to open the filter drop‑down	  
list. Select one of the four available filters to insert into the 
block.

Alternatively, right-click the Filter block and select Insert,  
then select a filter to insert it into the block (see figure 39 on 
the next page).
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Figure 39.	 Insert Filter Drop-Down List

Once an initial filter is selected, the Filter block changes to display	       
the type of filter applied. For example, if High Pass Filter is selected,  
the Filter block would display HIGH PASS instead of FILT. If multiple  
filters are applied, the Filter block displays FILT over a dark green field.

Once a filter is applied to the Filter block, double-click the block to  
open the Filter dialog box.

1	 Filter Channel 
Name

2	 Filter Graph

3	 Filter List

4	 Set Defaults 
Button

5	 OK Button

6	 Cancel Button

7	 Filters Help Button

Figure 40.	 Filter Dialog Box

1	 Filter Channel Name — This name changes to match the default or user defined input 
name.

2	 Filter Graph — Graphically displays the applied filter curve and provides handles for 
adjusting filter parameters. Numbers along the top of the graph represent the filter curve 
of the corresponding slot in the filter list below the graph. The number appears over the 
center frequency of the filter.

If a filter is active (not bypassed), it appears as a solid red curve. If a filter is bypassed, it 
appears as a broken orange curve (such as the bass filter in slot 2).

NOTE:	 All filters are bypassed by default.

3	 Filter List — Provides filter drop-down lists for all three available filter slots. Frequency, 
Slope, Boost/Cut, Q, and Bypass controls are also available in this list.

Available filters include:

•	 High Pass Butterworth •	 High Pass Linkwitz-Riley •	 Treble

•	 Low Pass Butterworth •	 Low Pass Linkwitz-Riley •	 Parametric

•	 Bass

NOTE:	 See the DSP Configurator Help File for more information on each of the 
filters. Click the Filters Help button to open the help file topic discussing 
filters.
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4	 Set Defaults Button (see figure 40 on the previous page) — 	  
Resets all filter parameters of all filters in the filter list to their  
default values.

To reset a single filter to default parameters, right‑click the  
filter number on the left side of the Filter dialog box, and  
select Set to Default (see the image on the right).

5	 OK Button — Confirms changes made to the contained parameters and closes the 
Filter dialog box.

6	 Cancel Button — Reverts any changes made to the contained parameters back to 
their states when the current instance of the Filter dialog box was opened and closes 
the dialog box.

7	 Filters Help Button — Opens the About Filters topic in the DSP Configurator Help 
File. This help file topic discusses each filter type in greater detail.

Input Dynamics Blocks

Double‑click the Dynamics block to open the dynamics	  
drop-down list.

From the Dynamics drop‑down list, two types of dynamics  
processors are available. Select a dynamics processor type to  
insert it into the Dynamics block.

There is one Dynamics block available per mic/line input channel. Each block can be 
configured with any of the processor types.

The two types of dynamics processors available are:

•	 Compressor               

•	 Limiter

Once a dynamics processor is inserted, double‑click the dynamics block icon to open the 
corresponding dialog box.

If a dynamics processor has been inserted and needs to be changed to a different dynamics 
processor, right-click the dynamics block, hover over Insert, and select a new processor 
to insert it (see figure 41).	

Figure 41.	 Changing Dynamics Processors
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Compressor

1	 Compressor Channel Name

2	 Compressor Graph

3	 Compressor Parameters List and Control

4	 Bypass Button

5	 Set Defaults Button

6	 OK Button

7	 Cancel button

8	 Dynamics Help Button

Figure 42.	 Compressor Dialog Box

1	 Compressor Channel Name — This name changes to match the default or user 
defined input name.

2	 Compressor Graph — Graphically displays compressor parameter settings. 
Parameters can also be adjusted using this graph. Click and drag the dot within the 
green area of the graph to adjust the compressor Threshold. Click and drag the dot 
outside the green box to adjust the compressor Ratio.

3	 Compressor Parameters List and Control — Lists all configurable parameters for 
the compressor. 

•	 Text fields are available to adjust Threshold, Ratio, Attack Time, Hold Time, 
and Release Time. 

•	 Click and drag sliders to adjust Attack Time, Hold Time, and Release Time. 

•	 Click a slider once and use the <Left Arrow> and <Right Arrow> keys to adjust 
the respective parameter in 1 ms steps. 

•	 Select the Soft Knee checkbox to provide a more natural implementation of 
compression when the signal reaches the threshold.

4	 Bypass Button — Bypasses the compressor. When the button is red, bypass is 
enabled.

5	 Set Defaults Button — Resets all compressor parameters to their default values. To 
view individual parameter default values, see the DSP Configurator Help File by clicking 
the Dynamics Help button (8) to open the About Dynamics topic.

6	 OK Button — Confirms changes made to the contained parameters and closes the 
Compressor dialog box.

7	 Cancel Button — Reverts any changes made to the contained parameters back to 
their states when the current instance of the Compressor dialog box was opened and 
closes the dialog box.

8	 Dynamics Help Button — Opens the Dynamics Operation topic of the 
DSP Configurator Help File for further assistance in operating dynamics processors.
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Limiter

1	 Limiter Channel Name

2	 Limiter Graph

3	 Limiter Parameters List and Control

4	 Bypass button

5	 Set Defaults button

6	 OK button

7	 Cancel button

8	 Dynamics Help button

Figure 43.	 Limiter Dialog Box

1	 Limiter Channel Name — This name changes to match the default or user defined 
input name.

2	 Limiter Graph — Graphically displays limiter parameter settings. Parameters can also 
be adjusted using this graph. 

•	 Click and drag the dot on the graph to adjust the limiter Threshold.

3	 Limiter Parameters List and Control — Lists all configurable parameters for the 
limiter. 

•	 Text fields are available to adjust Threshold, Attack Time, Hold Time, and 
Release Time. 

•	 Click and drag sliders to adjust Attack Time, Hold Time, and Release Time.

•	 Click a slider once and use the <Left Arrow> and <Right Arrow> keys to adjust 
the respective parameter in 1 ms steps. 

•	 Select the Soft Knee checkbox to provide a more gradual implementation of 
limiting when the signal reaches the threshold.

4	 Bypass Button — Bypasses the limiter. When the button is red, bypass is enabled.

5	 Set Defaults Button — Resets all limiter parameters to their default values. 

To view individual parameter default values, see the DSP Configurator Help File by 
clicking the Dynamics Help button (8) and navigate to the About Dynamics topic.

6	 OK Button — Confirms changes made to the contained parameters and closes the 
Limiter dialog box.

7	 Cancel Button — Reverts any changes made to the contained parameters back to 
their states when the current instance of the Limiter dialog box was opened and 
closes the dialog box.

8	 Dynamics Help Button — Opens the Dynamics Operation topic of the 
DSP Configurator Help File for further assistance in operating dynamics processors.

43  



 

NetPA Ultra Series • DSP Configurator Software 42

Input Ducking Block

The duck block contains a ducking processor as well as an adaptive gain processor.

•	 Ducker — Decreases levels on specified channels when signal is present above a set 
threshold on the duck source (trigger).

•	 Adaptive Gain — Increases levels on specified channels when signal is present above 
a set threshold on the adaptive gain source channel (trigger).

Double-click the Duck block to open the drop‑down list where	  
the Ducker and Adaptive Gain processors can be selected.

Select Ducker to insert a ducking processor into the duck block  
(as seen on the right). Select Adaptive Gain to insert an  
adaptive gain processor into the duck block. Depending on the                             
processor selected, the duck block displays DUCK for a ducker  
or AG for adaptive gain.

If a ducking processor has been inserted and needs to be changed to a an adaptive gain 
processor, or vice versa, right-click the block and hover over Insert to insert a different 
processor (see figure 44).

Figure 44.	 Changing Ducking Processor

Ducker

After inserting a ducker processor, double‑click the Duck icon to open the 
Ducker Configuration dialog box.

1

2

3

4 1	 Duck Source Configuration

2	 Duck Parameter Settings

3	 Duck Priority Tree

4	 Ducking Operation Help Button

Figure 45.	 Ducker Configuration Dialog Box
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1	 Duck Source Configuration (see figure 45 on the previous page) — The Enable 
Source Mic/Line checkbox is checked when a ducker is inserted (default). In the Duck 
column, check the inputs that are ducked. In the by (dB) column, enter the amount of 
ducking that occurs on each channel selected in the Duck column. When the threshold 
is exceeded on the duck source, ducking occurs on the selected channels.

2	 Duck Parameter Settings — Contains controls for setting Threshold, Attack Time, 
Hold Time, and Release. Click the Ducking Operation Help button (4) to open the 
Ducking Operation topic in the DSP Configurator Help File.

3	 Duck Priority Tree — Displays the ducking priority for all Input and Aux In channels. 
Select another input to populate the Ducker Configuration dialog with the ducker 
information for that channel. Channels with an adaptive gain processor are appended 
with an (AG). Channels with adaptive gain processors cannot be selected from this 
dialog box.

4	 Ducking Operation Help Button — Opens the Ducking Operation topic of the 
DSP Configurator Help File for further assistance in ducker configuration.

Adaptive Gain

After inserting an adaptive gain processor, double‑click the AG icon to open the 
Adaptive Gain dialog box.

1

2

4 1	 Adaptive Gain Source Configuration

2	 Adaptive Gain Parameter Settings

3	 Adaptive Gain Help Button

Figure 46.	 Adaptive Gain Dialog Box

1	 Adaptive Gain Source Configuration — In the Add Gain To column, check the 
inputs that have gain added by the adaptive gain processor. In the Max Gain (dB) 
column, enter the maximum amount of gain applied to each channel selected in the Add 
Gain To column. When a box is checked, gain is applied to that channel when signal 
exceeds the threshold on the adaptive gain trigger channel.

NOTE:	 For every 1 dB of signal beyond the level set in the Threshold field, 1 dB of 
gain is added to the channels selected in the Add Gain To column. This occurs 
until the maximum gain set in the Max Gain (dB) field has been applied.
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2	 Adaptive Gain Parameter Settings (see figure 46 on the previous page) — Contains 
controls for Threshold, Attack Time, Hold Time, and Release Time.

3	 Adaptive Gain Help Button — Opens the About Adaptive Gain topic in the 
DSP Configurator Help File. This help file topic discusses the Adaptive Gain window 
in greater detail.

Input Pre-Mixer Gain Block

Double‑click the pre-mixer Gain block (as seen on the right) to open the 	  
Pre-mixer Gain dialog box.

The Pre-mixer Gain dialog box provides controls to boost, attenuate, and mute  
the signal after input processing occurs and before it is sent to the mix matrix.

1

2

3

4

5 6

7 1	 Input Name

2	 Pre-mixer Gain Fader

3	 Pre-mixer Gain Text Box

4	 Mute Button

5	 OK Button

6	 Cancel Button

7	 Pre-mixer Gain Help Button

Figure 47.	 Input Pre-mixer Gain Dialog Box

1	 Input Name — This name changes to match the default or user defined input name.

2	 Pre-mixer Gain Fader — Click and drag the gain fader to provide up to 12 dB of gain 
or 100 dB of attenuation in 1 dB steps. Click the fader and use the <Up Arrow> or 
<Down Arrow> keys to adjust the fader up or down in 1 dB steps.

3	 Pre-mixer Gain Text Box — Enter a gain or attenuation value in 0.1 dB steps.

4	 Mute Button — Mutes signal at the pre‑mixer stage, preventing it from reaching the 
mix matrices.

5	 Input Pre-mixer Gain Dialog Box— Confirms changes made to the contained 
parameters and closes the Pre-mixer Gain dialog box.

6	 Cancel Button — Reverts any changes made to the contained parameters back to 
their states when the current instance of the Pre-mixer Gain dialog box was opened 
and closes the dialog box.

7	 Pre-mixer Gain Help Button — Opens the Pre-mixer Gain topic of the 
DSP Configurator Help File for further assistance in understanding operating the 
Pre‑mixer Gain dialog.
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AT Inputs
AT inputs receive signal from the Dante network when connected to an audio network. The 
NetPA Ultra series amplifiers can receive four channels of audio via Dante.

Renaming an Input

NOTE:	 Renaming an AT input in DSP Configurator affects the receiver name in 
Dante Controller. Alternatively, renaming a receiver channel name in Dante Controller 
affects the name displayed in DSP Configurator (see Renaming a Receiver or 
Transmitter on page 79).

1.	 Click the expansion or AT input name field.

2.	 Delete or highlight the text and type the desired name.

3.	 Press the <Enter> key or navigate away from the field to 
confirm and apply the new name. Press the <Down Arrow>  
key to navigate to and highlight the next name field.

NOTE:	 Follow the same procedure to edit an AT Input name.

AT Inputs Overview

AT inputs allow an amplifier to receive signal from the audio network. Network audio routing 
is done with Dante Controller (see Dante Controller on page 75).

Figure 48.	 AT Inputs

AT Inputs Processing
The AT inputs contain three processor blocks and a meter block in their signal chain:

1.	 Meter Block

2.	 Filter Block

3.	 Dynamics Block

•	 Compressor Block

•	 Limiter Block

4.	 Ducker Block

•	 Ducker Block

•	 Adaptive Gain Block

5.	 Pre-Mixer Gain Block
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AT Input Meter Block

1	 AT Input Name — This name changes to match the 
default or user defined input name.

2	 AT Input Meter — Provides a readout to view input 
activity.

3	 Meter Help Button — Opens the AT Input Meter topic 
of the DSP Configurator Help File for further assistance in 
understanding operating the AT Input Meter dialog.

Figure 49.	 AT Input Meter Block

AT Input Filter Block

The AT input filter block functions the same as the mic/line input filter block.

AT Input Dynamics Block

The AT input dynamics block functions the same as the mic/line input dynamics block.

AT Input Ducker Block

The AT input ducker block functions the same as the mic/line input ducker block.

AT Input Pre-Mixer Gain Block

The AT input pre-mixer gain block functions the same as the mic/line input pre‑mixer gain 
block.
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Mix-Points
DSP Configurator contains four mix matrices that connect all inputs and outputs. The mix 
matrices set post-processing mix levels.

Each input is connected to a mix-point for the signal to be routed to an output. In general, 
mix levels are set relative to each other, achieving a blend of input signals at an optimal 
output level, close to, but not exceeding 0 dBFS at the output.

NOTE:	 In order for mix-points to appear in the workspace, the input group sending 
signal to the mix-point must be expanded and the input channel must be visible.

     

Figure 50.	 DSP Configurator Mix Matrices
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Mix-Point Dialog Box

Double-click a mix-point to open the Mix-point dialog box.  
Alternatively, highlight a mix‑point with a single click and press the  
<Enter> key to open the Mix-point dialog box.

1	 Mix-Point Input and Output — Displays which input (top)  
and output (bottom) the mix-point is connecting.

2	 Mix-point fader — Click and drag the mix-point fader 
to provide up to 12 dB of gain or 100 dB of attenuation 
in 1 dB steps. Click the fader and use the <Up Arrow> or 
<Down Arrow> keys to change the level in 1 dB steps.

3	 Level Text box — Allows specific level values to be entered  
in 0.1 dB steps.

4	 Mute button — Mutes the mix-point (muted by default).  
When the button is red, the mix point is muted.

5	 Mix Dot selection — Two radio buttons allow selection of  
the type of input processing applied to the mix-point.  
Include Processors includes signal processing at the 
mix-point and marks the mix‑dot teal to signify this. Bypass 
Processors bypasses signal processing at the mix-point 
and marks the mix‑dot green to signify signal processing is 
bypassed.

6	 OK button — Confirms changes made to the contained 
parameters and closes the Mix-point dialog box.

7	 Cancel button — Reverts any changes made to the  
contained parameters back to their states when the current 
instance of the Mix-Point dialog box was opened and  
closes the dialog box.

1

2

3

4

5

6 7

8

8	 Mix-point Help button — Opens the Mix-Point topic of  
the DSP Configurator Help File for further assistance in  
understanding operating the Mix-Point dialog.
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Mix-Point Context Menu

Right-click a mix-point to open the mix-point context menu. This menu provides quick 
options to operate mix-points.

1	 Mute — Mutes the mix-point.

2	 Unmute — Unmutes the mix-point and creates an audio 
path between an input and output.

3	 Include Processors — Includes signal processing at the 
mix-point and marks the mix‑dot teal to signify this.

4	 Bypass Processors — Bypasses signal processing at 
the mix-point and marks the mix‑dot green to signify signal 
processing is bypassed.

5	 Cut — Cuts the mix-point parameter configuration, 
preparing it to be pasted to another mix-point. The 
parameter configuration information is not removed until it  
is pasted to another mix-point.

6	 Copy — Copies the mix-point parameter configuration, 
leaving the mix-point intact and preparing it to be pasted  
to another mix-point.

1
2
3
4

5
6
7

8

9
¢

7	 Paste — Pastes a previously cut or copied mix-point parameter configuration to the 
selected mix-point.

8	 Delete — Deletes the mix-point parameter configuration and mutes the mix-point.

9	 Mark Row — Marks the entire row containing the selected mix-point, highlighting all 
of the elements.

¢	 Unmark Row — Unmarks the entire row containing the selected mix-point.

DSP Configurator Outputs
The outputs run along the top right of the main workspace in DSP Configurator. There are 
two types of outputs available:

•	 Line/AT Outputs (NetPA U 1004)

•	 Amplifier Outputs

These outputs receive signal when mix-point connections are made between an input and 
an output in the mix-matrices.

Each output panel can be expanded or collapsed by clicking the  (expand) or  (collapse) 
buttons.
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Line/AT Outputs (NetPA U 1004)
In the NetPA U 1004, four outputs are available in the Line and AT Outputs panel and route 
signals to the four balanced/unbalanced line level outputs as well as the four AT outputs. 
Signals routed to these outputs are also transmitted on the Dante network. 

Figure 51.	 Outputs Panel for the NetPA U 1004

Line/AT Outputs (NetPA U 1002)
The NetPA U 1002 has two separate channels for the line outputs and two separate 
channels for the AT outputs. Each output has to be routed to individually.  

Figure 52.	 Outputs Panel for the NetPA U 1002

Naming an Output
1.	 Click the output name field.
2.	 Delete the text and type the desired output name.	
3.	 Press the <Enter> key or navigate away from the field to  

confirm and apply the new output name. 
4.	 Press the <Down Arrow> key to navigate to and highlight the 

next name field.

NOTE:	 Follow the same procedure to edit an Output name.

Line/AT Output Building Blocks

Extron building blocks are a quick configuration tool that can significantly reduce 
configuration time. A building block is a collection of processor and gain settings for an 
input or output processing chain. These building blocks have been built by Extron based on 
extensive use and testing with each intended application or specific device.

Figure 53.	 Accessing Building Blocks on an Output
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Click the output number to open the Building Blocks dialog box.

1

2 3 4

5 1	 Output Building Blocks List

2	 Add a Building Block Button

3	 Delete a Building Block Button

4	 New Folder Button

5	 Building Blocks Help Button

Figure 54.	 Output Building Blocks Dialog Box

1	 Output Building Blocks List — Contains building blocks for output channels.

2	 Add a Building Block Button — Allows users to create custom building blocks, 
saving the currently applied gain and processor settings on the selected channel. Click 
the icon to open the Add a Building Block dialog box. This allows users to name the 
new custom building block and choose the folder to save the block to an existing folder, 
or create a new folder.

Figure 55.	 Add a Building Block Dialog Box

3	 Delete a Building Block Button — Deletes the currently selected building block or 
building block folder. If default building blocks are deleted, they can be restored from the 
Organize Building Blocks dialog box.

4	 New Folder Button — Creates a new folder or sub-folder.

5	 Building Blocks Help Button — Opens the Building Blocks topic of the 
DSP Configurator Help File. This topic contains more information on the different types 
of building blocks for inputs and outputs.
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Line/AT Output Processing
The output processing chain in DSP Configurator is represented by a string of blocks (see 
figure 56). Each block contains a specific processor or type of processor. Each output 
contains the following processor chain:

•	 Line/AT Output Trim Block

•	 Line/AT Output Delay Block

•	 Line/AT Output Filter Block

•	 Line/AT Output Dynamics Block

•	 Line/AT Output Attenuation Block

Figure 56.	 Output Processing Chain

Line/AT Output Trim Block

Double-click the output Trim block to open the Post-mixer Trim dialog box.	

The Post-mixer Trim dialog box provides pre-processing gain and attenuation  
control for the selected output.

1

2

34 5

1

2

3

4 5

1	 Output Name — This name changes to match the default or 
user defined output name

2	 Post-mixer Trim Fader — Click and drag the trim fader 
to provide up to 12 dB of gain or 12 dB of attenuation in 
0.1 dB steps. Click the trim fader and use the <Up Arrow> or 
<Down Arrow> to adjust the fader up or down in 0.1 dB steps.

3	 Post-mixer Trim Text Box — Allows the user to enter a gain 
or attenuation value in 0.1 dB steps.

4	 OK Button — Confirms changes made to the contained 
parameters and closes the Post-mixer Trim dialog box.

5	 Cancel Button — Reverts any changes made to the 
contained parameters back to their states when the current 
instance of the Post-mixer Trim dialog box was opened and 
closes the dialog box.

Figure 57.	 Post-mixer Trim Dialog Box
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Line/AT Output Delay Block

Double-click the Delay block to open the delay drop down. Click	  
Delay to insert the delay processor into the block.

Once a delay processor is inserted into the Delay block, double-click  
the block to open the Delay dialog box.		

1

2

3

4

5

6

7

8

9 1	 Delay channel name

2	 Units of measurement

3	 Delay fader and text box

4	 Temperature panel

5	 OK button

6	 Set Defaults

7	 Cancel button

8	 Bypass button

9	 Delay Help button

Figure 58.	 Delay Dialog Box

1	 Delay channel name — The name changes to match the default of user defined 
output name.

2	 Units of measurement — Radio buttons change the unit of measurement used by 
the delay fader and text box. Samples, Milliseconds, Feet and Meters are available 
units of measurement. Values are converted when the unit of measurement is changed. 
Changing the unit of measurement does not alter the amount of delay applied to the 
signal.

3	 Delay fader and text box — Adjust the amount of delay applied to the signal. Click 
and drag the fader up or down to increase or decrease the amount of delay. Click the 
fader once and use the <Up Arrow> or <Down Arrow> to adjust delay in one sample 
step (or the one sample equivalent in milliseconds, feet, or meters). Use the text box 
below the fader to input a delay value.

4	 Temperature panel — Becomes available when using delay in feet or meters. 
Compensates delay for ambient temperature in the acoustic space. Temperature is not 
available when using samples or milliseconds as the unit of measurement.

5	 OK button — Confirms changes made to contained parameters and closes the Delay 
dialog box.

6	 Set Defaults button — Resets the delay to the default setting.

7	 Cancel button — Reverts any changes made to the contained parameters back to 
their states when the current instance of the Delay dialog box was opened and closes 
the dialog box.

8	 Bypass button — Bypasses the delay. When the button is red, bypass is enabled.

9	 Delay Help button — Opens the Delay Operation topic of the DSP Configurator 
Help File for further assistance in understanding operating the delay processor.
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Line/AT Output Filter Block

One filter block is available for each output channel. This filter block functions the same 
as the mic/line input filter block (see Input Filter Block on page 37 for information on 
configuring input filters).

Line/AT Output Dynamics Block

One dynamics block is available for each output channel. This block functions the same 
as the mic/line input dynamics block (see Input Dynamics Blocks on page 39 for 
information on configuring the output dynamics block).

Line/AT Output Attenuation Block

Double-click the output Attenuation block to open the Attenuation dialog box.	

The Attenuation dialog box provides attenuation control for the selected output.
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1	 Output name — This name changes to match the default 
or user defined output name.

2	 Output attenuation fader — Click and drag the trim 
fader to provide up to 100 dB of attenuation. Click the trim 
fader and use the <Up Arrow> or <Down Arrow> to adjust 
the fader up or down in 1 dB steps.

3	 Output attenuation text box — Allows the user to enter 
a gain or attenuation value in 0.1 dB steps.

4	 dBFS meter — Provides post-attenuation and pre-mute a 
readout of the output signal level.

5	 dBFS text readout — Displays a numerical readout of the 
output signal level

6	 Polarity button — Click this button to invert the signal 
polarity of the selected output.

•	 When the button displays the black + symbol on a 
gray field ( ), the polarity is normal. 

•	 When the button displays the black - symbol on a 
yellow field ( ), the polarity is inverted.

7	 Mute button — Mutes the signal at the output stage.

8	 OK button — Confirms changes made to the contained parameters and closes the 
Attenuation dialog box.

9	 Cancel button — Reverts any changes made to the contained parameters back to 
their states when the current instance of the Attenuation dialog box was opened and 
closes the dialog box.
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Balancing NetPA Amplifier Output Level and XPA Input Sensitivity
Setting proper gain structure is necessary to ensure maximum audio clarity and amplifier 
output performance. To properly balance the input sensitivity of XPA amplifiers, when used 
in conjunction with NetPA Ultra Series amplifiers, follow the steps outlined below. 

NOTE:	 When setting levels, pay attention to avoid digital clipping.

The following is an example of how to adjust the NetPA U 1002/1004 internal amplifiers to 
match an external XPA amplifier connected to the NetPA U 1002/1004 line outputs:

1.	 Ensure the NetPA U 1002/1004 outputs are properly connected to the XPA amplifier 
inputs. Refer to the NetPA U 1002/1004 User Guide and XPA User Guide found on  
www.extron.com for more details on connecting the amplifiers.

2.	 Set the attenuation potentiometer on the XPA input to -10 dB (12 o’clock position).

3.	 Open DSP Configurator and connect live to  
the NetPA U 1002/1004.

4.	 Double-click the Line Output ATT block 	  
(highlighted in yellow) to open the attenuation  
dialog box (see the image on the right).

5.	 Set the Line Output attenuator(s) to -7 dB.  
The attenuation value can be adjusted by  
either dragging the fader (see figure 59, 1),  
or clicking in the display box (2), and  
manually entering the desired value.

11111

222

3

Figure 59.	 Line Out Dialog Box

6.	 Click OK (3) to apply the change and close the dialog box.

7.	 Double-click the Amplifier Output ATT block (highlighted in yellow in figure 60 on the 
next page) to open the attenuation dialog (see figure 62 on the next page). 
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Figure 60.	 Amplifier Outputs Block

8.	 Set the Amp Out attenuator(s) to 0 dB (see figure 62). The attenuation value can be 
adjusted by either dragging the fader (1), or clicking in the display box (2), and  
manually entering the desired value.

111

222

333

Figure 61.	 Amp Out Dialog Box

9.	 Click OK (3) to apply the change and close the dialog box.

Amplifier Outputs
The NetPA U 1004, features four discrete processing paths to the amplifier outputs, while 
the NetPA U 1002 features two processing paths to the amplifier outputs. All audio inputs 
can be routed to an amplifier output via discrete amplifier output mix-points.

Figure 62.	 Amplifier Output Panel for the NetPA U 1004

Figure 63.	 Amplifier Output Panel for the NetPA U 1002
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Naming an Amplifier Output
1.	 Click the Amplifier Output name field.

2.	 Delete the text and type the desired Amplifier Output name.

3.	 Press the <Enter> key or navigate away from the field to confirm 
and apply the new output name. 

4.	 Press the <Down Arrow> to navigate to and highlight the next 
name field.

NOTE:	 Follow the same procedure to edit an output name.

Amplifier Outputs Processing
The amplifier output processing chain in DSP Configurator is represented by a string of 
blocks (see figure 64). Each block contains a specific processor or type of processor. The 
processor chain is as follows:

•	 Amplifier Output Trim Block

•	 Amplifier Output Delay Block

•	 Amplifier Output Filter Block

•	 Amplifier Output Dynamics Block

•	 Amplifier Output Attenuation Block

Figure 64.	 Amplifier Output Processing Chain

Amplifier Output Trim Block

One trim block is available for each amplifier output channel. The trim block functions the 
same as the line/AT output trim block (see Line/AT Output Trim Block on page 52) for 
information on configuring output filters).

Amplifier Output Delay Block

One delay block is available for each amplifier output channel. The delay block functions the 
same as the line/AT output delay block (see Line/AT Output Delay Block on page 53) 
for information on configuring output filters).

Amplifier Output Filter Block

One filter block is available for each amplifier output channel. This filter block functions the 
same as the line/AT output filter block (see Input Filter Block on page 37) for information 
on configuring output filters).
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High-Pass Filter Information

For high impedance amplifiers like the NetPA U 1004-70V/100V and 
NetPA U 1002-70V/100V, a fixed high-pass filter is inserted into the output chain of the 
amplified outputs. This filter takes up one of the filter slots in the output filter block. This 
high-pass filter is inserted to prevent the saturation of the transformer cores in the 70V/100V 
speaker chain by low frequency content. The filter corner frequency and slope can be 
adjusted. The frequency adjustment has a lower limit of 35 Hz. The filter cannot be deleted, 
and the filter type cannot be changed.

Figure 65.	 High-Pass Filter

Amplifier Output Dynamics Block

One dynamics block is available for each amplifier output channel. This block functions the 
same as the line/AT input dynamics block (see Input Dynamics Blocks on page 39) for 
information on configuring the output dynamics block).

Amplifier Output Attenuation Block

One attenuation block is available for each amplifier output channel. The attenuation 
block functions the same as the line/AT output attenuation block (see Line/AT Output 
Attenuation Block on page 54) for information on configuring output filters).

Monitoring
The monitoring section of the workspace contains read-only information about the 
NetPA Ultra device.

1	 Enable Monitoring check box

2	 Reset Flag Status button

3	 Global Status section

4	 Global Status faults

5	 Amplifer Output Status section

6	 Fault statuses section

Figure 66.	 Monitoring Panel
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1	 Enable Monitoring check box (see figure 66 on the previous page) — To enable the 
monitoring feature, click this check box.

NOTE:	

•	 Enabling monitoring in DSP Configurator only enables it while using 
DSP Configurator.

•	 Enabling monitoring does not enable or disable unsolicited responses.

•	 For details on using the monitoring feature outside of DSP Configurator, see 
Status Commands on page 102.

2	 Reset Flag Status button (see figure 66) —   Click to reset all status flags.

NOTE:	

•	 If the fault condition is still occurring, the flag remains red following the reset.

•	 Status flags are reset when power is cycled.

•	 Once a system has been serviced to address a fault, the status flags should 
be reset, either all at once through the reset status flag button, SIS, or 
individually through SIS.

3	 Global Status section (see figure 66) —

•	 Unit temperature — Displays the internal temperature of the amplifier at a 
particular location.

•	 Power Save State — Indicates the standby state that the amplifier is currently in.

•	 Active (Auto Timer Disabled) — The Auto-Standby Timer is disabled, and 
the amplifier does NOT automatically enter standby mode when no active 
signal is present on any amp channel for 25 minutes.

•	 Active (Auto Timer running but not triggered) — The Auto-Standby 
Timer is enabled. The amplifier remains active while there is an active signal 
on any amp channel. The amplifier enters standby mode if no active signal is 
present on any amp channel for 25 minutes. It returns to active upon detection 
of signal on any amp channel. When the SIS command is sent, the timer resets.

•	 Standby (SIS triggered) — When the amplifier is forced into standby via SIS 
through DSP Configurator or a control system, the unit does not wake from 
standby until the amplifier is placed into Standby Mode 0 or 1 (Active [Auto 
Timer Disabled] or Active [Auto Timer running but not triggered], respectively) 
the same way, regardless of signal presence.

•	 Standby (Timer triggered) — The amplifier has entered standby mode 
because no active signal was present on any amp channel for 25 minutes. It 
returns to active upon detection of signal on any amp channel.

•	 Standby (Contact Closure triggered) — The amplifier has been forced into 
standby via the STANDBY port (contact closure), and remains in this state until 
the contact is opened. Once opened, the amplifier returns to its last known 
active standby state. This function overrides all other standby conditions.
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4	 Global Status faults (see figure 66) — These are faults that are not specific to an 
amplifier channel, see table below for details on the specific faults.

Status Possible Triggers Possible Causes Possible Solutions

Over Temp The amplifier has exceeded 
the recommended operating 
temperature.  
See specifications on 
the Extron website, 
www.extron.com. 

The ambient environment 
exceeds the recommended 
operating temperature.

•	 Verify that the placement of the 
amplifier allows for suitable ventilation 
and airflow 

•	 Avoid placing equipment on top or 
below the amplifier. 

•	 Verify that the operating temperature is 
within the specified range.

DC Protection A DC signal has been 
detected on an amplifier 
channel.

Hardware failure. •	 Disconnect power then reconnect 
power to the unit to determine if the 
unit immediately goes into standby 
upon power up

•	 The amplifier may need to be serviced.

Loss of AC •	 If a “2” is reported: 
Loss of AC is detected.

•	 If a “1” is reported: 
A momentary loss of 
AC power has been 
detected in the past. 

There is or has been a 
disruption in power.

Check the system power distribution.

Main power 
supply fault

The main power supply 
has shut down for reasons 
other than loss of AC, going 
into standby, or DC protect 
and is effectively muting all 
output channels.

•	 The power supply has 
overheated.

•	 There is a damaged 
component.

•	 Allow the amplifier to cool down.
•	 Make sure the correct speaker load is 

connected.
•	 Check that speakers are tapped 

appropriately.
•	 Recheck the amplifier gain structure.
•	 Verify that the amplifier ambient 

environment does not exceed the 
recommended operating temperature 
(see suggestions for Over Temp).

5	 Amplifer Output Status section (see figure 66 on page 58) — Signal Presence 
indicates the presence of or lack of a signal on a particular channel.

•	 Green when the audio signal crosses the signal detection threshold of the output 
channel (−60 dBFS).

•	 Gray when the audio signal does not cross the signal detection threshold of the 
output channel.

http://www.extron.com
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6	 Fault statuses section (see figure 66) — These are faults specific to an amplifier 
channel, see table below for details on the specific faults.

Status Possible Triggers Possible Causes Possible Solutions

Output Thermal 
limiting

The specified amplifier 
channel has overheated 
and is muting the affected 
channel. 

•	 The channel is driving 
too low of a speaker 
load impedance.

•	 The channel is being 
fed a heavily clipped or 
distorted signal. 

•	 The amplifier operating 
environment exceeds 
the recommended 
operating temperature.

•	 Make sure the correct speaker load is 
connected.

•	 Check that speakers are tapped 
appropriately.

•	 Recheck the amplifier gain structure.
•	 Verify that the amplifier ambient 

environment does not exceed the 
recommended operating temperature 
(see suggestions for Over Temp on 
the previous page).

Overload •	 The current or power 
limiter has been 
triggered. 

•	 A short on the affected 
output channel has 
been detected.  

•	 Too much current is 
being drawn due to 
overdriving the output. 

•	 An improper speaker 
load has been attached 
(for example, attaching 
a low impedance 
speaker to a high 
impedance output). 

•	 The output has been 
shorted. 

•	 Recheck the amplifier gain structure.
•	 For low-impedance loads: Verify that 

total impedance at the amplifier is 
≥ 4 ohms.

•	 For 70V/100V speaker loads: Recheck 
speaker taps.

•	 Check for shorts at the output and 
throughout the speaker chain.

Open Circuit The affected channel has 
detected an open circuit.

•	 The connection to the 
speaker chain has been 
broken.

•	 An improper speaker 
load has been attached 
(for example, attaching 
a high impedance 
speaker to a low 
impedance output). 

•	 No speaker load is 
attached. 

•	 Check for an open circuit at the output 
and throughout the speaker chain. 

•	 Recheck speaker taps.  

Digital clip Audio output sounds 
distorted. 

The output DAC is being 
overdriven.

Recheck the amplifier gain structure.

Unit in standby  The unit has been placed 
into standby.

•	 The auto-standby timer 
has timed out. 

•	 The contact closure 
port is engaged on the 
rear panel. 

•	 SIS has forced the unit 
into standby. 

•	 DC has been detected 
on an output.

•	 Check that there is sufficient signal 
going to the amplifier channel. 

•	 Check that the standby port is not 
engaged. 

•	 Check that the SIS is not forcing the 
unit into standby. 

•	 If none of the above work, check 
for a DC fault (see suggestions for 
DC protection).

7	 Legend — (see figure 66 on page 58) 

•	 Red — The amplifier is actively detecting a fault.

•	 Yellow — The amplifier is not actively detecting a fault, but one has been detected 
since the last time the status flags were reset.

•	 Gray — The amplifier has never detected a fault.
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Open Circuit Detect
For high impedance amplifiers, open circuit detect requires that the speaker chain be 
tapped at a minimum of 16 Watts.

For this detection circuit to function, adequate audio signal must be present at the output 
channel. The output attenuation meters should be bouncing above -50 dBFS.

If at any point an open circuit is detected (yellow or red status), the system should be 
inspected.

Loss of AC
Since status flags are reset after a power cycle, the amplifier only reports this fault for the 
short time it remains active after it loses power. This is generally enough time for it to report 
loss of power to DSP Configurator before disconnecting. Once power is restored and 
DSP Configurator reconnects, the indicator is gray.

In the event that this status is yellow while DSP Configurator is connected to the amplifier, 
this represents a short disruption in power.
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Configuration Tools

This section contains information for configuring certain tools and options that are found 
under the Tools menu in DSP Configurator and covers the following topics:

•	 Presets •	 Connect/Disconnect from Device •	 Device Settings

•	 Groups •	 Firmware Loader •	 Options

•	 Device Manager •	 Organize Building Blocks

Presets
Preset options are available from the Tools menu. 

Figure 67.	 Presets Options

1	Mark All Items — Marks all gain blocks, processor blocks, 
and mix-points in the main workspace. Performing this function 
before saving a preset ensures every element in the workspace 
is saved to the preset.

2	Save Preset — Saves the marked blocks and mix points of 
the current configuration as a preset. When Save Preset is 
clicked, the dialog box opens showing that only the elements 
marked with a green outline are saved to the preset. This 
option is only available if items are marked.

3	Clear Marked Items — Unmarks all currently marked 
elements.
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Methods for Marking Items
Marked items are highlighted in green (see figure 68). There are four ways to mark items in 
DSP Configurator:

•	 Mark All — Press <Ctrl+A> on the keyboard to mark all items in the main workspace.

•	 Mark Group — Click and drag the cursor to create a box around a group of items to 
mark them. 

Click and drag the cursor while holding the <Shift> key to create box around another 
group of items to mark them while keeping previous group marked.

•	 Mark Series — Click the first item in the series to mark it, then press <Shift+Click> 
on the final item in the series. All items between the first and last items are marked. 

•	 Mark Multiple Individual – Click the first item to mark it and press <Ctrl+Click> to 
mark additional items anywhere in the main workspace.

Figure 68.	 Marked Items Highlighted in Green

Configuring Presets
1.	 Create a configuration to be saved as a preset (see DSP Configurator Software on 

page 28).

2.	 Mark the items to be included in the preset.

3.	 Select Tools > Presets > Save Preset. 

4.	 From the Save a Preset dialog box, enter the preset number (1 through 8) in the 
Preset Number field (see figure 69, 1). Preset slots that do not already have a preset 
assigned read unassigned. Enter a name into the Preset Name field (2), 12 character 
maximum).

5.	 Click OK (3) to save the preset.

1

2
3

Figure 69.	 Save a Preset Dialog Box

NOTE:	 When a configuration file is pushed to a NetPA Ultra Series amplifier, presets 
contained within that file are available for recall from DSP Configurator or SIS 
commands.

6.	 The preset is saved and is available from the Presets	  
drop-down list at the top of the main workspace.
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Groups
Groups allow master control of gain and mute for groups of channels. Groups are used in 
control configurations.

Click Tools > Configure Groups to open the Configure Groups dialog box.

1	 Select Group

2	 Select Control Type

3	 Available Group Member

4	 Change Name button

5	 Apply button

6	 Delete Current Group button

7	 Close button

Figure 70.	 Group Controls Dialog Box

1 	Select Group — Provides a drop-down list to select the number of the group to be 
configured. If the group has been configured and named, the group name appears next 
to the group number. If the group slot is empty, it reads <empty> next to the group 
number. There are 32 group slots available.

2 	Select Control Type — Group controls can manage gain and mute for the specified  
inputs, mix-points, or outputs. From the Select Control Type panel, select the type of 
control from the Gain or Mute lists.

3 	Available Group Members — This section populates according to the selected 
control type and lists all inputs, mix-points, and outputs available to be added as group 
members. Check the box next to a member to add it to the group. Group members 
must be the same control type. The maximum number of group members for a single 
group is 8.

4 	Change Name button — Once a group has been created, select it from the Select 
Group drop‑down list (1), click Change Name to change the name of the selected 
group.

5 	Apply button — Click Apply after changes to a group have been made. The Confirm 
Group Details dialog box opens allowing the group name and number to be edited. 
Click OK to apply group changes.

6 	Delete Current Group button — Select a group from the Select Group drop‑down 
list and click Delete Current Group to delete the group.

7 	Close button — Click Close to close the dialog box. Any changes that have not been 
applied are lost.
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Configuring Groups
To create a new group:

1.	 Select Tools > Configure Groups to open the Configure Groups dialog box.

2.	 From the Select Group drop-down list, select a group slot to configure (see figure 71, 
1).

3.	 From the Select Control Type panel (2), expand a control type. 

4.	 Choose which gain stage the control type affects.

5.	 From the Available Group Members panel, select the channels to be configured as 
group members (3). 

6.	 Click Apply (4).

1 2 3

4
Figure 71.	 Configure Groups Dialog Box

7.	 Confirm the group number and name from the Confirm Group Details dialog box 
(see figure 72, 1).

8.	 Click OK to confirm all details and create the group (2).

111

222

Figure 72.	 Confirm Group Details Dialog Box
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To edit an existing group:

1.	 Select Tools > Configure Groups to open the Configure Groups dialog box (see 
figure 73).

2.	 From the Select Group drop-down list (1), select an existing group to edit.

3.	 From the Select Control Type panel (2), expand a control type. 

4.	 Choose which gain stage to edit.

5.	 From the Available Group Members panel (3), select or deselect channels to be 
members of the group. 

6.	 Click Apply (4).

7.	 From the Confirm Group Details dialog box, the group number and group name can 
be edited (5).

8.	 Click OK to confirm the group details (6).

9.	 When the Overwrite Group dialog box opens, click OK to confirm the changes made 
to the group.

To edit only a group name:

1.	 Choose the group from the Select Group drop-down list (1).

2.	 Click Change Name (7).

3.	 From the Change Group Name dialog box, enter the new group name into its field (5).

4.	 Click OK (6).

4

5 5

1

7

2 3

4

6

Figure 73.	 Editing a Group
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Device Manager
Device Manager is used to configure and switch between multiple devices in Live or 
Emulate mode within DSP Configurator (see figure 74). Devices can be placed and ordered 
in user-created folders for easily tracking systems with devices across multiple rooms. When 
Device Manager contains multiple devices, all device configurations are saved in a single 
DSP Configurator file.

Select Tools > Device Manager to open the Device Manager dialog box.

1 2 3 4 5
6

Figure 74.	 Device Manager Dialog Box

1	 Add Device Button — Click the  button to open the DSP Configurator splash 
screen to select another device to be configured. As a device is chosen or connected, it 
is added to the Device Manager dialog box.

2	 Clone Device Button — Click the  button to clone the currently selected device. 
When a device is cloned, information within the device configuration file is also cloned.

NOTE:	 If Live mode is enabled, a backup may need to be performed before the 
device can be successfully cloned.

3	 Remove Device Button — Click the  button to remove the currently selected 
device from the device manager. Select a folder and click this button to delete the folder 
and all devices it contains.

4	 Expand and Collapse All Buttons — Click the  icon to expand all folders and 
show the devices it contains. Click the  to collapse all folders.

5	 New Folder Button — Click the  button to create a new folder to drag a device into. 

6	 Device List Panel — Lists the devices and folders in Live and Emulate mode. From 
this panel, devices can be clicked and dragged into folders, placed in custom order, and 
folders can be renamed. If the device is connected via LAN, the device IP is displayed. 
Double-clicking a device in this list initiates a pull (see figure 88 on page 80).

The color of the icon next to a device name indicates Live or Emulate status, as well 
as whether the device is configured as a Primary or Secondary EXP device. Devices 
with color icons are in Live mode. Devices with grayed icons are in Emulate mode. 
Devices with blue icons are configured as Secondary units.
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Managing Devices in Device Manager
To add a device:

1.	 Click Tools > Device Manager to open the 
Device Manager dialog box.

2.	 Click the Add Device button (see figure 75, 1).

3.	 From the DSP Configurator splash screen drop-
down, select the device to be added to Device 
Manager (see figure 76, 1). 

Select Connect... to open the Connect to 
device... dialog box and directly connect 
with a device. When connecting directly, 
DSP Configurator performs a pull of the newly 
connected device configuration.

1

Figure 75.	 Adding a Device

4.	 Click OK (2).

1

2

Figure 76.	 Selecting a Device to be Added

To arrange devices into a folder:

1.	 From the Device Manager dialog box, click the New Folder button (see figure 77, 1).

2.	 Enter a name for the folder. The text for the folder name is automatically highlighted and 
ready to be edited (2).

NOTE:	 Folders can be renamed later by clicking twice on the folder name and 
editing the text.

3.	 Press <Enter>.

4.	 Click and drag devices over the folder name and release to insert the devices into a 
folder (3).

2

1

3

 

Figure 77.	 Arranging Devices Into a Folder
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Connect/Disconnect from Device
When DSP Configurator is in Emulate mode, this selection in the Tools menu reads 
Connect to Device and opens the Connect to device... dialog box when selected. 
When DSP Configurator is in Live mode and connected to a device, this selection reads 
Disconnect from Device and disconnects DSP Configurator from the current device when 
selected, and returns to Emulate mode.

For detailed instructions on connecting to an amplifier, see Connect to a NetPA Ultra 
Series Amplifier in Live Mode on page 32. For detailed instructions on disconnecting 
from a NetPA Ultra Series amplifier, see Exit Live Mode and Enter Emulate Mode on 
page 34.	

Firmware Loader
Select Tools > Firmware Loader to open the Extron Firmware Loader software from 
DSP Configurator. Firmware Loader assists users in updating firmware or uploading new 
firmware to devices via RS-232 or USB connection. Refer to the Firmware Loader Help File 
for more information in using the Firmware Loader software.

NOTE:	 Extron Firmware Loader software must be installed on the host PC in order for it 
to be opened.

Downloading Firmware Updates
1.	 Go to www.extron.com and click the Download tab at the top of the page.

2.	 From the Download page, select the Firmware link near the middle of the page.

3.	 The Firmware link opens the firmware Download Center page. Click N from the 
alphabet list at the top of the page.

4.	 Select the Download link at the right side of the NetPA Ultra Series amplifier listing.

NOTES: 

•	 You must have an Extron Insider account and log in to that account to 
download the firmware.

•	 The firmware release notes provide details about the changes between 
different firmware versions. The file can be downloaded from the same page 
as the firmware.

5.	 Submit the required information and follow the on-screen instructions to start the 
download. Note where the file is saved.

6.	 From the save location, open the executable (.exe) file.

7.	 Follow the instructions on the firmware upgrade Installation Wizard screens to install the 
new firmware on the computer.

8.	 Once the installer has been run, the Firmware Upgrade dialog box opens, click Next 
to begin the installation process.

9.	 The terms of installation must be agreed to. Select the I accept... radio button and 
click Next.

10.	An installation status dialog box opens that displays the completion status of firmware 
download and installation.

http://www.extron.com
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11.	When the firmware is installed, the Firmware Upgrade dialog box displays that the 
installation is complete and the install location of the firmware file. By default, firmware is 
installed in either: 

•	 Program Files (x86) > Extron > Firmware > NetPA_U_1002 > vx.xx

•	 Program Files (x86) > Extron > Firmware > NetPA_U_1004 > vx.xx

•	 If the View the Release Notes checkbox is checked, a PDF of the firmware 
release notes opens automatically. Likewise, if the View the Update Install 
checkbox is checked, a PDF of the update notes open automatically. The boxes are 
checked by default.

•	 Click Finish to close the dialog box.

12.	Use Firmware Loader to update the amplifier firmware. Refer to the Firmware Loader 
Help File for more information in using the Firmware Loader software.

Organize Building Blocks
Extron building blocks are a quick configuration tool that can significantly reduce 
configuration time. A building block is a collection of processor and gain settings for an input 
or output processing chain. Building blocks have been built by Extron based on extensive 
use and testing with each intended application or specific device. The Organize Building 
Blocks dialog box allows users to organize building blocks to their preference, import new 
building blocks, export existing building blocks, delete building blocks, and restore default 
building blocks that may have been deleted by the user. Building blocks in the Organize 
Building Blocks dialog are organized into folders for easily locating building blocks for a 
multitude of applications.

Select Tools > Organize Building Blocks to open the Organize Building Blocks 
dialog box.

111 222 333 444 555

666

1	Export Building Blocks File button

2	Import Building Blocks File button

3	Delete Building Block button

4	Restore Default Building Blocks 
button

5	New Folder button

6	Building Blocks panel

Figure 78.	 Organize Building Blocks Dialog Box

1	 Export Building Blocks File button — Click the  button to export the selected 
building block file to be saved to a disk.

NOTE:	 Building block files have an XML extension.

2	 Import Building Blocks File button — Click the  button to browse the computer 
for building block files to import to DSP Configurator.

3	 Delete Building Block button — Click the  button to delete the currently selected 
building block. 
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4	 Restore Default Building Blocks button (see figure 78 on the previous page) — If 
default building blocks that come installed with DSP Configurator are deleted, click the 

 button to restore them.

NOTE:	 Only the default building blocks can be restored with this function. User 
created building blocks are not restored if deleted.

TIP:	 To avoid accidentally deleting user created building block files, once they are 
created, export them to a safe location on the disk. This creates a backup copy 
of the building block file, should it be deleted by the user by mistake.

5	 New Folder button — Click the  button to create a new folder that building blocks 
can be dragged into. Upon creation, a default folder name is highlighted and a custom 
name can be entered. Click a folder name twice to edit the folder name.

6	 Building Blocks panel — This panel contains folders and building blocks. Click and 
drag building blocks to change their order or place them inside folders. Click a building 
block name twice to edit the building block name. Click a folder name twice to edit the 
name of the folder.

Device Settings
The Device Settings dialog box provides access to general settings of a NetPA Ultra 
Series amplifier. Select Tools > Device Settings to open the Device Settings dialog 
box. Device settings are only available when connected live to a device.

Within the Device Settings dialog box, the following tabs are available:

•	 Unit Info •	 Serial Settings •	 Dante Device

Unit Info
The Unit Info tab displays the unit name, firmware version, device model, device part 
number, and device MAC address.

Figure 79.	 Unit Info Tab
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Serial Settings 
The Serial Settings tab display the baud rate of the rear panel RS-232 port.

Figure 80.	 Serial Settings Tab

Dante Device 
This tab allows the NetPA Ultra Series Dante settings to be configured within 
DSP Configurator without opening Dante Controller. 

ATTENTION: 	 It is essential that a Dante device be named immediately after it is 
connected to the Dante network and before audio connections with other devices 
are established. Existing connections are removed when a device is renamed.

ATTENTION :	 Il est essentiel qu'un appareil Dante soit nommé immédiatement 
après sa connexion au réseau Dante et avant l'établissement de connexions audio 
avec d'autres appareils. Les connexions existantes sont supprimées lorsqu'un 
périphérique est renommé.

Dante Device Name

A Dante device can be renamed to identify the device on the audio network.

To assign the Dante device name:

1.	 Select Tools > Device Settings.

2.	 Use the arrows to navigate to the Dante Device tab.

3.	 Click the Device name text box.

4.	 Enter a device name for the Dante interface.

5.	 Click Apply. A confirmation dialog box opens.

6.	 Click Yes, to confirm removing existing connections after the name is changed.

Dante Device Network Settings

To configure Dante network settings:

1.	 Select the DHCP or Static IP radio buttons. If using DHCP, the NetPA Ultra Series 
Dante interface is assigned an IP address by the DHCP server and Dante network 
configuration is complete. If Static IP is selected, proceed to step 2.

2.	 Enter a valid network configuration into the respective fields.

3.	 Click Apply.
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To reboot the Dante interface:

•	 Click Reboot Dante. Only the Dante interface reboots, not the entire unit.

To refresh the device name and network configuration displayed:

•	 Click Refresh to have DSP Configurator refresh information from the NetPA Ultra Series 
Dante interface.

Options
The Options dialog box allows the user to edit and reset default options for 
DSP Configurator color schemes, default processor and gain block behavior, as well as a 
number of other settings. For a comprehensive overview of the Options dialog box, see the 
DSP Configurator Help File.
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Dante Controller

This section describes the NetPA Ultra Series network installation, configuration, and control 
using Dante Controller for Windows and covers the following topics:

•	 Overview

•	 Downloading and Installing Dante Controller

•	 Configuring a NetPA Ultra Series Amplifier in Dante Controller

•	 Dante Controller Operation

•	 Dante Troubleshooting

Overview
NetPA Ultra Series amplifiers use Dante technology by Audinate to provide high 
performance digital audio networking over standard TCP/IP networks. The Dante Controller 
software application is used to route audio on the network. Dante allows audio channels 
to be transported across a switched Ethernet data network while meeting the quality 
requirements of professional audio.

Up to 4 channels can be transmitted from a NetPA U 1004 amplifier (2 channels on the 
NetPA U 1002) to the Dante network and up to 4 channels can be received by a  
NetPA U 1004 amplifier (2 channels on the NetPA U 1002) from the Dante network. Audio 
signals are converted by NetPA Ultra Series amplifiers, processed and routed to the Line/AT 
Outputs, and transmitted onto the Dante network. Audinate recommends the Dante audio 
network be kept separate from other networks. However, the audio network can be shared 
with control traffic or unrelated data traffic. Audio channels can be unicast or multicast to 
make the best use of available bandwidth.

The NetPA Ultra Series amplifiers are receivers and transmitters for audio signals on a Dante 
Network. This is possible via the unit AT port. The amplifiers can be found anywhere on the 
Ethernet network and can be relocated without reconfiguring the unit or the network. Dante 
Controller can configure (but is not limited to) Dante channel routing and naming, device 
naming, obtaining network and device status, and setting the device IP address.

NOTES: 

•	 The AT port can be set to 44.1 kHz, 48 kHz, 88.2 kHz or 96 kHz, however the 
signal going through the DSP is converted to and processed at 48 kHz.

•	 For applications where the line and Dante outputs may be used independently 
during long periods of no amplifier activity, such as when the unit is being used 
as both an amplifier and off/on-ramp to the Dante network, the auto-standby 
timer must be disabled and the amplifier must not be forced into standby mode.
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Downloading and Installing Dante Controller
Dante Controller from Audinate is required to route transmitters and receivers and can be 
used to configure Dante settings and monitor performance. Install Dante Controller on a PC 
running Microsoft® Windows® 7 or newer. For full details about computer requirements and 
to download the software, see the Dante Controller product page at www.extron.com.

To download Dante Controller:

1.	 From www.extron.com, hover over the Download tab at the top of the page.

2.	 From the Featured Software list, select Dante Controller.

3.	 From the Dante Controller product page, click the blue Download button.

4.	 Select Run to run the Dante Controller installer. Select Save to save the install file to run 
at a later time.

5.	 If you choose to run the file, follow all prompts. If you saved the file, click the saved file 
to begin installation when ready. 

The installed Dante Controller program files are saved in: 
C:\Program Files (x86)\Audinate\Dante Controller\DanteController.exe.

Configuring a NetPA Ultra Series Amplifier in Dante Controller
Use a standard Ethernet cable to connect the NetPA Ultra Series to a Dante network via the 
rear panel AT port (see Rear Panel Features on page 15) and power the device.

Device Name
Multiple devices on the same Dante network can present difficulty in identifying individual 
devices. To avoid confusion and difficulty, ensure the following steps are taken:

•	 Connect devices to the Dante network one at a time.

•	 Rename each device before making audio connections in Dante Controller.

•	 Rename each device with a unique and meaningful identifier.

•	 Rename each device before the next device is connected to the Dante network.

See Renaming the NetPA Ultra Series Amplifier in Dante Controller on the next page 
for renaming procedure.

ATTENTION:	 It is essential that a Dante device be named before audio subscriptions 
with other devices are established. Existing subscriptions are removed when a device 
is renamed.

ATTENTION :	 Il est essentiel qu'un appareil Dante soit nommé avant l'établissement 
des abonnements audio avec d'autres appareils. Les abonnements existants sont 
supprimés lorsqu'un appareil est renommé.

In Dante Controller, a device can be renamed to identify the device on the audio network. 
The default device name of the NetPA Ultra Series consists of the model name, followed by 
the last six characters of the Dante interface MAC address (for example, NetPA-U-xxxxxx). 
In addition to renaming the device, individual Transmitter (Tx) and Receiver (Rx) channels 
can be renamed.

https://www.extron.com
https://www.extron.com
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Receiver and Transmitter Names
In addition to renaming a device, individual transmitter and receiver channels can be 
renamed in Dante Controller. Rename transmitter and receiver channels to reflect the 
location of the device or the purpose of the transmitter or receiver. Ensure transmitter and 
receiver channels are renamed before making audio connections between devices. See 
Renaming a Receiver or Transmitter on page 79 for renaming procedure.

Dante Controller Naming Conventions
•	 Device names follow Domain Name System (DNS) hostname rules. Legal characters are 

A-Z, a-z, 0-9, and hyphen (-). Names must begin with a letter and cannot end with a 
hyphen (-).

•	 Dante Tx and Rx channel names (also known as labels) can be up to 31 characters in 
length. Label names are not case-sensitive. For example, ANALOG OUT-1 and analog 
out-1 are recognized as the same name. Unicode and non-roman characters are not 
supported.

•	 Tx and Rx channel labels can use any character except equals (=), period (.), or @.

•	 Tx and Rx channel labels must be unique on a device but do not need to be unique on 
the network.

Renaming the NetPA Ultra Series Amplifier in Dante Controller

NOTE:	 Dante device naming can also be done via DSP Configurator (see Device 
Manager on page 68).

1.	 Ensure that the control computer and a single NetPA Ultra Series amplifier is connected 
to the same network.

2.	 From the control computer Start menu select: 
All Programs > Audinate > Dante Controller > Dante Controller

3.	 The Dante Controller - Network View screen opens. All Dante devices on the 
network are discovered and listed.

4.	 From the Device menu, select Device View or press <Ctrl+D> on the keyboard (see 
figure 81).

Figure 81.	 Opening Device View

5.	 The Dante Controller - Device View dialog opens. Select the device being 
configured from the (Select a Dante Device...) drop‑down list (see figure 82, 1).

1

Figure 82.	 Device View and Select a Dante Device Drop-Down

81  
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NOTE:	 If there are multiple NetPA Ultra Series devices connected to the network 
that have not been renamed, obtain the Dante interface media access code 
(MAC) address of the desired device from the white label on the rear panel of the 
device in order to identify it in Dante Controller.

The Device View dialog populates with the selected NetPA Ultra Series information.

Figure 83.	 Populated Device View Dialog Box

6.	 Click the Device Config tab (see figure 84, 1) to open the Device Config page.

7.	 In the Rename Device panel, enter the new name of the device in the text field. No 
spaces are allowed in the name. Names should be significant identifiers. For example, 
enter NetPAUAmplifier-MainRack (2).

8.	 Click Apply (3). 

A confirmation prompt opens.

1

2
3

Figure 84.	 Device Config Dialog, Rename Device

9.	 Click Yes (see figure 85, 1) to confirm the new name, then close the Device 
Configuration dialog box. The new name is written to the Dante interface of the 
NetPA Ultra Series amplifier. Repeat as necessary for all devices.

1

Figure 85.	 Rename Device Confirmation Dialog Box

83  
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Renaming a Receiver or Transmitter
In addition to renaming devices, individual receiver and transmitter channels can be 
renamed in Dante Controller. To better organize the various receivers and transmitters, 
it is recommended each receiver and each transmitter be named using a description of 
the device they belong to, the location of the device, or the purpose of the receiver or 
transmitter.

To view the receiver or transmitter channels in Dante Controller, click the plus (+) sign next to 
the receiver or transmitter device name to expand it. The plus (+) sign becomes a minus (-) 
sign when the device is expanded (see figure 86, 1).

1

2

Figure 86.	 Expanded Device View — Input and Output Names

TIP:	 To simplify setup and operation of large matrix systems, rename the receiver and 
transmitter channels to better indicate the source at the transmitters or 
receivers.

Renaming a Receiver
The default names shown in the Dante Receivers column are extracted from the Dante 
interface of the connected device (see figure 87, 1 on page 80). The NetPA Ultra Series 
receivers are labelled AT Input 1 through AT Input 4. Follow the instructions below to 
rename a receiver.

To rename a NetPA Ultra Series receiver:

1.	 From the Device menu on the Network View screen, select Device View, or press 
<Ctrl+D> on the keyboard. The Device View dialog box opens.

2.	 From the (Select a Dante Device..) drop-down list, select the name of the 
desired NetPA Ultra Series amplifier (see figure 87, 1).

3.	 On the Device View screen, select the Receive tab (2).

4.	 Click on the name of the receiver to be renamed. The name becomes a text box with a 
cursor (3).

5.	 Enter the new name (up to 31 characters) using any combination of letters, numbers, 
and special characters except for @, =, and . (period).

6.	 Press <Enter> on the keyboard to confirm the name, or click another channel text box.

7.	 Repeat steps 4 through 6 to rename additional receiver channels.

8.	 When finished renaming receivers, close the Device View dialog box.

86  



 

NetPA Ultra Series • Dante Controller 80

 

1

2

3

Figure 87.	 Device View Screen — Renaming an Amplifier

Renaming a Transmitter

The default names shown in the Dante Transmitters column are extracted from the 
Dante interface of the connected device (see figure 87, 1). The NetPA Ultra Series 
receivers are labelled Line Output 1 through Line Output 4. Follow the instructions below 
to rename a transmitter.

To rename a NetPA Ultra Series transmitter:

1.	 From the Device menu on the Network View screen, select Device View, or press 
<Ctrl+D> on the keyboard. The Device View dialog box opens.

2.	 From the (Select a Dante Device..) drop-down list, select the name of the 
desired NetPA Ultra Series amplifier (see figure 88, 1).

3.	 On the Device View screen, select the Transmit tab (2).

4.	 Click on the name of the receiver to be renamed. The name becomes a text box with a 
cursor (3).

5.	 Enter the new name (up to 31 characters) using any combination of letters, numbers, 
and special characters except for @, =, and . (period).

6.	 Press <Enter> on the keyboard to confirm the name, or click another channel text box.

7.	 Repeat steps 4 through 6 to rename additional receiver channels.

8.	 When finished renaming receivers, close the Device View dialog box.

Finding a Dante Device IP Address
To find the IP address of a Dante device, the name of the device is needed (see Renaming 
the NetPA Ultra Series Amplifier in Dante Controller on page 77).

NOTE:	 If the NetPA Ultra Series amplifier has not been renamed, its default name 
consists of the product name followed by a hyphen, plus the last 6 digits of the device 
MAC address (for example, NetPA-U-xxxxxx).

1.	 Open Dante Controller.

2.	 On the Dante Controller-Network View screen, click the Device Info tab (see 
figure 88, 1).

3.	 On the Device Info page, locate the name of the NetPA Ultra Series in the 
Device Name column (2). The IP address is located in the Primary Address 
column (3). In the example, the IP address for the connected NetPA Ultra Series is 
192.168.254.254.

Figure 88.	 Device Info Page

87 
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Dante Controller Operation

Dante Transmitters and Receivers
A Dante network is comprised of transmitters that output digital audio onto the Dante 
network and receivers that receive digital audio input from the Dante network.

•	 Transmitters output digital audio from the device onto the audio network.

•	 Receivers take in digital audio from the audio network into the device.

NetPA Ultra Series Transmitters and Receivers
In the NetPA U 1004, the line output signals are parallel to their respective Dante output 
signal. The signal being sent out of a line output is the same signal being sent out of its 
respective Dante output. In the NetPA U 1002, the line outputs are independent of Dante 
outputs. Each output has to be routed independently. 

The NetPA Ultra Series AT input channels are Dante receivers because they receive digital 
audio signal from the Dante network that can then be routed and mixed into a mix matrix. 
The NetPA U 1004 has four Dante inputs, while the NetPA U 1002 has two Dante inputs.

Dante Routing Operation
Dante Controller is used for all network signal routing of transmitters and receivers for 
Dante-enabled devices. The NetPA Ultra Series transmitters and receivers are available in 
Dante Controller for routing to other Dante devices.

Routing Devices
After the NetPA Ultra Series amplifier is configured, the channels can be routed to the other 
Dante devices on the audio network. Channels transmitted to the network or received from 
the network are routed using the Dante Controller Routing tab on the Network View 
page (see figure 89 on page 82). The transmitters, listed horizontally along the top 
of the screen, and the receivers, listed vertically down the left side, form a matrix whose 
intersections are the connection points between the receivers and transmitters.

•	 To make a receiver-to-transmitter connection, click once on an intersection.

•	 To remove a connection, click on the icon at the intersection.

One of the following icons appears at each connection intersection, indicating the status of 
both the transmitter and receiver channels and the connections (subscriptions): 

Icon Description Icon Description

Indicates an active subscription. Indicates a broken subscription.

Indicates subscription is in 
progress.

Indicates the transmitting device 
has been removed from the 
network or is switched off.Indicates a pending subscription.

See the Dante Controller User Guide, available at www.audinate.com, for additional 
information.

http://www.audinate.com
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Creating Subscriptions Between Devices

1.	 Ensure the control computer and NetPA Ultra amplifier are connected to the same 
network.

2.	 From the start menu select: 
All Programs > Audinate > Dante Controller > Dante Controller

The Dante Controller - Network View screen opens.

Dante Controller auto-discovers Dante devices on the network and advertises itself to 
allow other Dante-enabled devices to communicate with it. Transmitters connect to 
receivers using the subscription matrix.

2

1

3
Figure 89.	 Routing Tab of Network View Screen

3.	 To show the transmitters of a Dante device, click the + box next to the desired device in 
the Dante Transmitters panel, such as NetPA-U-9175f2 (1). The plus (+) changes 
to a minus (–) sign when the device expands.

4.	 To show the receivers of a Dante device, click the + box next to the desired device in 
the Dante Receivers panel, such as NetPA-U-9175f2 (2).

5.	 Click the intersection of the desired subscription between a transmitter and a  
receiver (3). 

A check mark at the intersection indicates the subscription is made. A check mark also 
appears next to the receiver channel.

NOTE:	 A receiver can connect to only one transmitter. A transmitter can connect to 
multiple receivers.

Disconnecting Inputs from Outputs
To undo routing, click the junction again to disconnect the receiver from the transmitter.

NOTE:	 After making changes to Dante network routing such as subscriptions, device 
names, or channel labels, wait at least 5 seconds before disconnecting or powering 
down the devices. This ensures that the new information is properly saved to those 
devices. Device level configuration such as sample rates, latency, and clock settings 
are saved instantly.

89  
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Dante Troubleshooting
The most common Dante troubleshooting issues occur when devices are not discovered by 
Dante Controller or when routing is not successful. Both issues occur when software is not 
able to properly discover devices operating on the Dante network.

Before moving into more difficult troubleshooting, shut down Dante Controller and reseat the 
Ethernet cable connecting the PC to the Dante network and restart Dante Controller. This 
can be enough for the software to reacquire the Dante network.

If the problem persists, perform the following troubleshooting procedures in the order listed.

Simplifying the Network for Troubleshooting
If further troubleshooting of Dante Controller is necessary, begin by simplifying the network:

1.	 Bypass network switches by connecting two Dante-compatible units, such as a  
DMP 128 Plus AT and a NetPA U 1004, via their AT ports.  

2.	 Connect the PC to an unused AT port with an Ethernet cable.

3.	 Use Dante Controller to check if the issue was resolved before moving on to network 
interface troubleshooting. 

4.	 If the issue is resolved, add connections and hardware one at a time, checking for 
proper operation after each addition, until the point of failure is discovered (typically a 
bad cable or invalid redundant configuration).

Troubleshooting the Network Interface
If the issue is still present, continue to diagnose the PC network connections as described 
below. Check Dante Controller after each step to see if the problem is resolved.

1.	 Click the Choose a Dante Interface icon (see figure 90, 1). The Configure Dante 
Interfaces dialog box opens.

1

Figure 90.	 Choose a Dante Interface Icon

Be certain the correct LAN connection is selected (the PC LAN port that is physically 
connected to the AT network) and note the IP address.

Figure 91.	 Configure Dante Interfaces Dialog Box

90  
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2.	 If it is on, turn off the PC wireless adapter. Disable all connections except the LAN 
port connected to the Dante network (verify this is the correct port by checking the IP 
address shown in the Configure Dante Interfaces dialog). 

3.	 Turn off all anti-virus and firewall software on the computer.

4.	 Enable DHCP on the remaining network connection. This forces the computer to 
acquire an IP address from the Dante interface.

NOTE:	 A DHCP server must be on the network for DHCP to function correctly.

Restarting Dante Controller
If subscriptions or normal operation cannot be restored, restart Dante Controller software. 
To access the Dante Controller Help File, do any of the following:

•	 Click the Help icon in the upper-right corner of the Network View screen (see figure 92).

•	 Select Help, then Online Help or Offline Help from the menu.

•	 Press the <F1> key on the computer keyboard for online help or <Shift+F1> for offline 
help.

Figure 92.	 Accessing the Dante Help File

92  
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Remote Control and 
Configuration

This section describes how to control the NetPA Ultra Series power amplifiers with SIS 
commands and covers the following topics:

•	 Connection Options •	 Symbol Definitions

•	 Host-to-Device Communications •	 Command and Response Table

•	 Using the Command and Response Tables •	 Object ID (OID) Number Tables

Connection Options
The NetPA U 1002 and NetPA U 1004 can both be remotely connected via a host computer 
or other device (such as a control system) attached to the rear panel RS-232 port, AT port, 
or the USB Config port.

The NetPA Ultra Series amplifiers can be set up and controlled using SIS commands or 
DSP Configurator software (see Rear Panel Features on page 15) for details on the 
configuration and control port connections). For information on DSP Configurator, (see 
Accessing the DSP Configurator Help File on page 29).

SIS Commands can be sent to Dante audio interface devices through a DMP Plus device. 
To learn how to do this, visit www.extron.com and read any of the user guides from the 
DMP Plus series of matrix processors, such as the DMP 128 Plus. 

SIS commands can be executed using the Extron DataViewer application available from 
www.extron.com. The host computer issuing the commands can be connected via the 
following connections:

•	 RS-232 Port	 •	 USB Config Port

RS-232 Port
The NetPA Ultra Series has a serial port that can be connected to a host device such as 
a computer running either the DataViewer or HyperTerminal utilities. The port makes serial 
control of the NetPA Ultra Series possible.

The NetPA Ultra Series  amplifiers use the following baud rate and protocols:

•	 38400 baud •	 8 data bits •	 1 stop bit •	 No parity

NOTES: 

•	 The rear panel configuration port requires 38400 baud communication. This 
speed is higher than most other Extron products. The NetPA Ultra Series control 
software automatically sets the connection for the appropriate speed. When 
using DataViewer or similar application, make sure the host PC or control system 
is set for 38400 baud.

•	 See Rear Panel Features on page 15 for additional details on connecting to 
the RS-232 port.

https://www.extron.com
https://www.extron.com
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AT Port
The NetPA Ultra Series amplifiers can be connected to a Dante network. SIS Commands 
can be sent to Dante audio interface devices through a DMP Plus device. To learn how to 
do this, visit www.extron.com and read any of the user guides from the DMP Plus series of 
matrix processors, such as the DMP 128 Plus. 

The NetPA Ultra Series amplifier Dante port defaults are as follows: 

•	 DHCP: ON

The Ethernet cable can be terminated as a straight-through cable or a crossover cable and 
must be properly terminated for your application. 

•	 Crossover cable — Direct connection between the computer and the NetPA Ultra 
Series amplifier.

•	 Straight-through (Patch) cable — Connection of the NetPA Ultra Series amplifier to 
an Ethernet LAN.

12345678

RJ-45
Connector

Insert Twisted
Pair Wires

Pins:

A cable that is wired as TIA/EIA T568A at one 
end and T568B at the other (Tx and Rx pairs 
reversed) is a "crossover" cable.

A cable wired the same at both ends is called 
a "straight-through" cable because no pin/pair 
assignments are swapped.

T568A T568B T568B T568B

Straight-through Cable
(for connection to a switch, hub, or router)

 End 1 End 2
 Pin Wire Color Pin Wire Color

  1 white-orange 1 white-orange
 2 orange 2 orange
 3 white-green 3 white-green
 4 blue 4 blue
 5 white-blue 5 white-blue
 6 green 6 green
 7 white-brown 7 white-brown
 8 brown 8 brown

Crossover Cable
(for direct connection to a PC)

 End 1 End 2
 Pin Wire Color Pin Wire Color

 1 white-orange 1 white-green
 2 orange 2 green
 3 white-green 3 white-orange
 4 blue 4 blue
 5 white-blue 5 white-blue
 6 green 6 orange
 7 white-brown 7 white-brown
 8 brown 8 brown

Figure 93.	 RJ-45 Ethernet Connector Pin Assignments

USB Config Port
The NetPA Ultra Series has a rear panel USB port that can be connected to a computer as 
a host device running the DataViewer utility for control of the device. Once a connection is 
established, SIS programming can begin (see Host-to-Device Communications on the 
next page).

Verbose Modes
To receive change notices, the session must be in verbose mode 1 or 3  (see Set verbose 
mode on page 90). In verbose mode 1 or 3, the unit reports changes in messages that 
resemble SIS command responses.

Tagged and Untagged Responses

•	 When a query command is sent in verbose mode 0 or 1, only the “untagged” value 
is returned. When a query command is sent in other verbose modes, the response is 
“tagged” and resembles the response to a set command.

•	 Example: The gain query command E G40000AU} is sent. The following responses 
appear depending on the verbose mode:

•	 Untagged (verbose 0 or 1): 600], just the gain value with no other information.

•	 Tagged (verbose 2 or 3): DsG40000*600], the type of query sent, the OID queried, 
and the gain value.

https://www.extron.com
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Host-to-Device Communications

NetPA Ultra Series-initiated Messages
The NetPA Ultra Series initiates messages under specific conditions. No response is 
required for the host. The NetPA Ultra Series-initiated messages are listed below.

Copyright Message

The NetPA Ultra Series initiates the following copyright message when it is first powered on 
or when a USB connection to the NetPA Ultra is made for the first time since the amplifier 
powered up.

(c) Copyright 2020, Extron Electronics, {model}, Vn.nn, 60-nnnn-nn]

•	 Vn.nn is the firmware version number.

•	 {model} is the full model name, NetPA U 1004, for example.

•	 60-nnnn-nn is the NetPA Ultra Series amplifier part number.

The NetPA Ultra Series amplifier sends the boot and copyright messages under the 
following circumstances:

•	 If the NetPA Ultra Series is off and RS-232 connection is already set up (the source 
PC is cabled to the NetPA Ultra Series and a serial communication program such as 
DataViewer is open), the connected unit sends these messages via RS-232 when first 
powered on.

•	 The NetPA Ultra sends the boot and copyright messages when a USB connection to 
the NetPA Ultra is made for the first time since the amplifier powered up.

Using the Command and Response Tables
SIS commands consist of a string (one or more characters per command field). No special 
characters are required to begin or end a command sequence. When a NetPA U amplifier 
determines a command is valid, it executes the command and sends a response to the host 
device. All responses end with a carriage return and a line feed, signaling the end of the 
response character string.

When programming, certain characters are more conveniently represented by their 
hexadecimal rather than ASCII values. The table below shows the hexadecimal equivalent of 
each ASCII character:

•

Space

l

I

ASCII to HEX  Conversion Table

Figure 94.	 ASCII to Hex Conversion Table

The Command and Response tables list valid ASCII commands, the NetPA Ultra Series 
responses to the host, and descriptions of the command functions with the results of 
executing the commands.
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Upper and lower case text can be used interchangeably except where noted.

NOTE:	 For commands and examples of computer or device responses used in this 
guide, the character “0” is the number zero and “O” is the capital letter “o.” 

Error Responses
When the NetPA Ultra Series is unable to execute the command, it returns an error 
response to the host. The error response codes and their descriptions are as follows:

E10 — Unrecognized command E18 — System/command timed out

E12 — Invalid port number E24 — Busy

E13 — Invalid parameter E25 — Device not present

E14 — Not valid for this configuration E30 — Hardware Failure (followed by colon 
and descriptor #)E17 — Invalid command for signal type

Symbol Definitions

•	 =	 Space
]]	 =	 Carriage return with line feed
}}	 =	 Carriage return with no line feed
|	 =	 Pipe (vertical bar) character. For URL-encoded commands, has the same function 

as }}.
EE	 =	 Escape
W	 =	 For URL-encoded commands, has the same function as EE

*	 =	 Asterisk character (which is a command character, not a variable)

NOTES: 

•	 Only instances marked with a • character require a space. Any spaces between 
characters in the command and response tables are only inserted for ease of 
reading.

•	 Unless stated otherwise, SIS commands are not case sensitive.
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Command and Response Table
Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Generic Hardware Setup and Access

Query Part Number N 60-1766-01 ] (1004)
60-1766-02 ] (1004-70V)
60-1766-12 ] (1004-100V)
60-1767-01 ] (1002)
60-1767-02 ] (1002-70V)
60-1767-12 ] (1002-100V)

Pno 60-1766-01 ]

Pno 60-1766-02 ]

Pno 60-1766-12 ]

Pno 60-1767-01]

Pno 60-1767-02 ]

Pno 60-1767-12 ]

Query Model Number 1I NetPA • U   • 1004
NetPA • U • 1004-70V
NetPA • U • 1004-100V
NetPA • U • 1002
NetPA • U • 1002-70V
NetPA • U • 1002-100V

Inf01 * NetPA •  U • 1004 ]

Inf01 * NetPA  •  U • 1004-70V ]

Inf01 * NetPA •  U • 1004-100V ]

Inf01 * NetPA •  U • 1002 ]

Inf01 * NetPA •  U • 1002-70V ]

Inf01 * NetPA  •  U • 1002-100V ]

Query Model
Description

2I 100 •  watt • 4 • Channel • low •  
impedance • amplifier • with •  
DSP  • and • Dante ] (1004)

Inf02 * 100 • watt • 4 • Channel • low • 

impedance • amplifier • with • DSP • and • 

Dante ] (1004)

100 • watt • 4 • Channel • 70 • volt  

• amplifier • with • DSP • and • Dante 
] (1004-70V)

Inf02 * 100 • watt  • 4 • Channel • 70 • volt 

• amplifier • with • DSP • and • Dante  ]  

(1004-70V)

100 • watt • 4 • Channel • 100 •  volt • 

amplifier  • with • DSP • and Dante ] 
(1004‑100V)

Inf02 * 100 • watt • 4 • Channel • 100 • volt 

• amplifier • with • DSP • and • Dante  ]  

(1004-100V)

100 • watt • 2 • Channel • low • 

impedance • amplifier • with DSP • 

Dante ]  (1002)

Inf02 * 100 • watt • 2 • Channel • low • 

impedance • amplifier • with • DSP • and • 

Dante  ] (1002)

100 • watt • 2 • Channel • 70 • volt • 
amplifier • with • DSP • and Dante 

] (1002-70V)

Inf02 * 100 • watt • 2 • Channel • 70 • 
volt • amplifier • with • DSP • and • 

Dante  ] (1002-70V)

100 • watt • 2 • Channel • 100 • volt • 

amplifier • with • DSP • and Dante ]  
(1002-100V)

Inf02*100 • watt • 2 • Channel • 100 • volt 

• amplifier • with • DSP • and • Dante  ]  

(1002-100V)

Query Firmware Version Q <version>] Ver01 * <version> ]

Query Firmware Version 
(w/patch)

*Q <version>] Bld * <version> 

Query embedded
OS type/version

14Q <embedded OS version>] Ver14 *<embedded OS version> ]

Query build and
any special-build text

20Q <version info + build and any 
special-buid text>]

Ver20 * <version info + build and 
any special-buid text> ]

Query detailed
Firmware Version

0Q X19(] Ver00 * X19(]

KEY:

X19(		 	 <bootloader version> - <factory code version> - <updated code version>
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Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Generic Hardware Setup and Access (continued)

Set verbose mode E  X2@ CV} Vrb  X2@] Vrb   X2@]

View verbose mode E  CV}  
Verbose mode 2/3

X2@] Vrb   X2@]

Reboot Dante Device E  BEXPD} ExpdB] Reboot only the Dante interface. NetPA 
device remains on during Dante reboot.

Query Current Status E   KEXPD} 
Verbose mode 2/3

X1^] ExpdK  X1^]

KEY:

X1^ = Soft limit High value

X2@ = Verbose/Response Mode		  0 = clear					     2 = tagged response for queries 
								        1 = verbose mode		  3 = verbose mode and tagged responses for queries

Network Commands

Set DHCP On E  D1EXPD} Expd D1 ] E13 is returned if DHCP is already enabled. 
DHCP must be off in order for this 
command to be accepted as valid (DHCP 
is enabled by default). Dante device reboot 
is also required for the command to take 
effect.

View DHCP status E  DEXPD} 
Verbose mode 2/3

X1%] ExpdD X1%]

Set Dante IP/subnet/
gateway

E  I  X# * X$ * X%
EXPD}

ExpdI  X# * X$ * X%] Using this command automatically turns 
DHCP  off. Dante device must be rebooted 
for new IP configuration to take effect (see 
the Reboot Dante device command in the 
previous page)

KEY:	 Baud Rate: 38400

X# = IP address	 xxx.xxx.xxx.xxx

X$ = Subnet mask 	 xxx.xxx.xxx.xxx

X% = Gateway IP 	 xxx.xxx.xxx.xxx

X1% = DHCP status 1 = enabled (default), 		  0 = disabled

View IP/subnet/gateway E IEXPD} 
Verbose mode 2/3

X#  *  X$  *  X%] ExpdI  X# * X$ * X%]

View MAC address E  HEXPD} X^] ExpdH    X^]

View Dante device name E  NEXPD} X&] ExpdN   X&]

KEY:	 Baud Rate: 38400

X# = IP address	 xxx.xxx.xxx.xxx

X$ = Subnet mask 	 xxx.xxx.xxx.xxx

X% = Gateway IP 	 xxx.xxx.xxx.xxx

X^ = MAC address xx-xx-xx-xx-xx-xx

X& = Dante device name Dante device name Device names follow Domain Name System (DNS) hostname rules. Legal characters are A-Z, 
a-z, 0-9, and hyphen (-). Names must begin with a letter and cannot end with a hyphen (-)
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Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Standby Commands

Disable standby E  0PSAV} Psav X12!]

NOTE:	 Turns off standby mode.

Enable auto standby 
(Default)

E  1PSAV} Psav X12!]

NOTE:	 The amplifier enters auto power save mode if there is no active signal for 25 minutes. Whenever this command is sent, the standby timer 
restarts and the amplifier goes into power save state.

Force standby on E  2PSAV} Psav X12!]

NOTE:	 Unit goes into standby and stays in standby until PSAV is set to another mode.

Query standby power 
mode, power save state

E  PSAV} 
Verbose mode 2/3

X12! * X12@] PsavX12! * X12@]

NOTES:	
•	 When the amplifier is first powered up, the amplifier will be in Psav1*1.

•	 Unsolicited responses will be sent out when the unit goes into or out of standby mode.

•	 Line outputs are disabled when in standby mode.

•	 Standby power mode should be set to ‘0’ if this amplifier is to be used as an off-ramp.

•	 Standby Priority:	 The standby contact closure port has the highest priority and supersedes SIS and the timer. 
	 SIS is the next highest priority and supersedes the timer. 
	 The timer has the lowest priority and can be overruled by contact closure and/or SIS.

KEY:

X12! = SIS Standby power mode 0 = auto standby timer disabled							       2 = standby triggered (SIS triggered)

1 = (Default) auto standby timer running, but not triggered

X12@ = Power save state 0 = unit is active and auto standby timer disabled				    2 = standby triggered (SIS triggered)

1 = (Default) auto standby timer running, but not triggered)	 3 = standby triggered (timer triggered)

4 = standby triggered (contact closure triggered

NOTE:	 When the standby contact closure is shorted, the unit goes into mode 4 and cannot come 
out of mode 4 until the port is no longer shorted. Once the short is removed the unit returns to its 
last known standby mode and the timer resets.

NOTE:	 Unsolicited responses will be sent out when the unit goes into or out of standby mode.

Force standby on
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Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Naming
Write Name

Write input name EX! , X@NI} Nmi X! , X@]

Write output name EX! , X@NO} Nmo X! , X@]

Write preset name EX# , X$NG} Nmg X# , X$]

Write group master name EN X1$ *nameGRPM} GrpmN X1$ *name]

View Name

View input name EX! NI}
Verbose mode 2/3

X@]
NmiX!,X@]

View output name EX! NO}
Verbose mode 2/3

X@]
Nmo X!,X@]

View group master name EN X1$ GRPM}

Verbose mode 2/3

name]
GrpmN  X1$ *name]

Presets

Recall Preset X# . Rpr X#]

KEY:	

X! = Input/output number Input:		  1 = Analog Line Input 1		  Output: 		  1 = Amplifier Output 1		  5 = Analog Line Output 1
 			   2 = Analog Line Input 2		  			   2 = Amplifier Output 2 		 6 = Analog Line Output 2 
 			   3 = Analog Line Input 3		   			   3 = Amplifier Output 3 		 7 = Analog Line Output 3 
 			   4 = Analog Line Input 4		   			   4 = Amplifier Output 4 		 8 = Analog Line Output 4

X@ = Input/output name 12 characters. Illegal characters: ~ , @ = ` [ ] { } < > ` “ ; : | \ and ?

X# = Preset number 1 to 8

X$ = Preset name Illegal characters: ~ , @ = ` [ ] { } < > ` “ ; : | \ and ?

X1$ = Group master number 1 through 32

Audio Level Control

NOTE:	 The command format is the same regardless of the control point, but the acceptable gain range varies depending on the control point.
•	 The mic/line input gain range is -18 dB to +60 dB in 0.1 dB increments. 
•	 The pre-mixer gain and virtual return gain range is -100 dB to +12 dB in 0.1 dB increments.
•	 The post-mixer gain and virtual return gain range is -12 dB to +12 dB in 0.1 dB increments. Post-mixer trim cannot be muted
•	 The output attenuation gain range is -100 dB to 0 dB in 0.1 dB increments.
•	 All responses are shown in Verbose Mode 2 or 3.

Set gain level E  G  X7@ *  X7# AU} DsG  X7@*X7#] Set gain on OID X7@ to a value of X7# dB.

Read gain level E  G  X7@  AU} DsG  X7@*X7#] Read gain on OID X7@ to a value of X7# dB.

KEY:

X7@ = Target OID See Object ID (OID) Number Tables on page 99.

X7# = Gain value
Levels use a 10x multiplier system with no decimal spaces. For example, a level of +10.4 dB would be entered as 104 
and a level of -3.2 dB would be entered as -32
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Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Audio Mute

Audio mute E  M  X7@ *1AU} DsM  X7@*1] Mute audio at X7@.

Audio unmute E  M  X7@*0AU} DsM  X7@*0] Unmute audio at X7@.

Mute status E  M  X7@  AU} DsM  X7@*X7$]

Audio Group Master Commands

NOTES:

•	 For information on configuring groups, see Groups on page 65.
•	 A group must have assigned members for these commands to have an effect.

•	 For X7$, a positive (+) value is assumed unless a negative (-) value is specified.

•	 If entering an X7$ value outside the valid range for the group or outside the soft limits, the amplifier responds with:
			   For gains:	 The maximum upper/lower range of the soft limit or maximum upper/lower range of the group. 
			   For mutes: 	 E13 error (invalid parameter X7$, X1$, and X1^ values can be sent without leading zeroes. 

Set a group fader value E  D  X1$*X1^GRPM} GrpmD   X1$*X1^] Set a group fader to a value of X1^.

		  Example: E D2*-239GRPM} GrpmD 2*-293] Set group 2 fader control to -29.3 dB.

Increment a group fader 
value

E  D  X1$ * X2) +GRPM} GrpmD X1$  * X1^] Increase the level of X1$ by X2) dB.

		  Example: E D2*30+GRPM} GrpmD2*-263] Raise the group 2 fader 3 dB from -29.3 dB 
(set in example above) to -26.3 dB.

Decrement a group fader 
value

E  D  X1$ * X2) - GRPM} GrpmD X1$  * X1^] Decrease the level of the X1$ group fader 
by X2) dB.

View the group fader 
value

E  D  X1$ GRPM}

Verbose mode 2/3

X1^]
GrpmD  X1$ * X1^]

Mute a group E  D X1$*1GRPM} Grpm D X1$*1] Mute all blocks in group X1$.

Unmute a group E  D X1$*0GRPM} Grpm D X1$*0] Unmute all blocks in group X1$.

View a group mute value E  D X1$GRPM} Grpm D X1$*X7$] For group masters, X7$ is always expressed 
as an unsigned or negative value.

Set soft limits ELX1$*X1&upper*
X1&lower GRPM}

GrpmL  X1$ * X1&*X1&] Set the groups soft limits to X1&upper and 
X1&lower.

		  Example: EL2*60*-60GRPM} GrpmL2*60*-60] Set the upper soft limit for the group 2 fader 
to +6.0 dB and the lower limit to -6.0 dB.

View soft limits E  L X1$GRPM}

Verbose mode 2/3

X1&*X1&]
GrpmL X1$ * X1& * X1&]

.

KEY:

X1$ = Group master number 1 through 32

X1^ = Group fader setting dB value in 0.1 dB steps, using negative numbers and eliminating decimal places using a 10x multiplier. 
-100.0dB to +80.0 dB is represented by -1000 to 800. The valid range depends on the type of gain or trim 
block assigned to the group number (X1$).

X1& = Group fader soft limit dB value in 0.1 dB steps. Gain uses 10x multiplier (+10 dB = 100+).

X7@ Target OID See Object ID (OID) Number Tables on page 97.

X7$ = Mute 0 = Unmute			   1 = Mute
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Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Audio Group Master Commands (continued)
View group type E  P  X1$ GRPM} GrpmP X1$  * X6&]

View group members E  O  X1$ GRPM} GrpmO X1$  * X5% 

1

*X5% 

2*...*X5%
n] X5* is the control address. In verbose 

modes 0 and 1, the response is simplified to  
X5% 

1

*X5% 

2*...*X5%
n]

KEY:

X5% = Target OID: See Object (OID) Number Tables on page 61

X1$ = Group master number: 1 through 32

X6& = Group type 6 = Unmute			   12 = Mute

Resets

Reset Status EX99( ZSTS} Zsts X99(] Reset the “x” flag of a selected status from 
1 to 0. Setting (variable X99() to “0” resets 
all statuses.

Reset presets and names E  ZG} Zpg]

Reset individual preset EX31! ZG} Zpg X31!]

System Reset 
(Factory Default

E  ZXXX} Zpx]

NOTES:	 Returns everything but the Dante settings to factory default conditions.

The following changes take place:

•	 Mix-points are set to unity gain (0 dBFS) and the following connections are made:

•	 AT input 1 is routed to amp output 1 and line output 1		  •	 AT input 3 is routed to amp output 3 and line output 3

•	 AT input 2 is routed to amp output 2 and line output 2		  •	 AT input 4 is routed to amp output 4 and line output 4

•	 All inputs, gain blocks, and line output attenuators are unmuted and set to unity gain.

•	 Trim blocks are set to unity gain; all amplified output attenuators are unmuted and set to -24 dB.

•	 Any inserted or active DSP is removed; all preset and group master memory is cleared.

•	 Status monitoring unsolicited responses are turned off.

•	 Standby timer is enabled; units not in standby.

KEY:

X31! = Preset # [8 max]

X99( = Status 0 = Resets all “x” flags from 1 to 0; 53, 54, 55, 57, 58, 60, 61, and 64 = Resets the specific ##STAT’s “x” flag(s) from one to zero.
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Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Status

Unsolicited responses are triggered whenever there is a change in status. Each status, when polled, gives the status at the time of polling.

NOTES: 

•	 Unsolicited responses are disabled by default for status commands that are capable of sending unsolicited responses. Unsolicited responses 
can be configured with the E M X10$ * X10%NTFY} command. 

•	 See View fault statuses of system below for more detail on the various fault statuses.

Monitoring Configuration E  M X10$ * X10% NTFY} NtfyM X10$*X10%] NtfyM X10$*X10%]

Configures which monitoring commands can report back unsolicited responses on which port.

View Monitoring 
Configuration

EMNTFY} X10$*X10%] NtfyM X10$*X10%]

KEY:

X10$ = Monitoring 
configuration 
(4-digits)

nBasicnDigital clipnOverloadnSignal presence

	 n = 1 or 0 	 1 = enabled			   0 = disabled   (Default = 0000) 
	 Enabled:  	 Unsolicited responses are sent out when there is a change in status. 
	 Disabled:  	 Unsolicited responses are disabled.
	 Basic monitoring includes		 •	 System over temp			   •	 Output open circuit 
								        •	 DC protect					     • 	 Main power supply status 
								        •	 Output Thermal limiting		  • 	 Loss of AC
								        •	 Standby status

X10% = Port 0 = All port (Default)			  1 = Dante	 (AT)		  2 = RS-232			   3 = USB
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Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Status (continued)

View internal operating 
temperature status in °C

E20STAT} 
Verbose mode 2/3

X9!] 
20StatX9!]

NOTE: 	 This indicates an internal temperature in the amplifier.

View fault statuses of 
system

E32STAT} 
Verbose mode 2/3

X9@*y11...y1n] 
32Stat X9@*y11...y1n]

NOTE:  	 X9@ gives an overview of the current status of the amplifier system and channels. Rather than ping every E##STAT} command, this 
command gives an overview of the current status of the system and channels.

KEY:	

X9! = xxx (degrees Celsius) Internal Temperature

X9@ = Global Fault Status (five digits) — 	 nSystem OvertempnDC ProtectnLoss of ACnPower Supply FaultnStandby Status

System Overtemp (53STAT): 			  0 = Not or never detected		 1 = No longer detected	 2 = Detected now 
	 Caution: Amplifier functionality has been modified to protect itself.
DC Protect (54STAT): 		  		  0 = Not or never detected		 1 = No longer detected	 2 = Detected now 
	 Service: This may not be a recoverable error; unit may need to be serviced.
Loss of AC (60STAT): 		  		  0 = Not or never detected		 1 = No longer detected	 2 = Detected now 
	 Error: Amplifier, in part or as a whole, has shut down or is misconnected.
Power Supply Fault (61STAT): 	 	 0 = Not or never detected		 1 = No longer detected	 2 = Detected now 
	 Error: Amplifier, in part or as a whole, has shut down or is misconnected.
Standby Status: 	 0 = unit is active and auto standby timer disabled			   3 = standby triggered (timer triggered) 
					     1 = auto standby timer running, but not triggered (default)		 4 = standby triggered (contact closure triggered) 
					     2 = standby triggered (SIS triggered)	

NOTE:	 When the standby contact closure is shorted, the unit goes into mode 4 and cannot come out of 
mode 4 until the port is no longer shorted. Once the short is removed,the unit goes back to its last known 
standby mode and the timer resets

Status: Noteworthy change made to amplifier operation

Y! = Channel Fault Status (five digits) — nSignal presencenOverloadnOutput thermal limitingnOutput open circuitnDigital clipping
Signal Presence (62STAT): 			   	 0 = Not present 		  	 1 = Present 
	 Status: Noteworthy change made to amplifier operation.
Overload (57STAT): 				    	 0 = Not or never detected 	 1 = No longer detected 	 2 = Detected now 
	 Caution: Amplifier functionality has been modified to protect itself.
Output Thermal Limiting (55STAT): 	 	 0 = Not or never detected 	 1 = No longer detected 	 2 = Detected now 
	 Caution: Amplifier functionality has been modified to protect itself.
Output Open Circuit (58STAT): 		  	 0 = Not or never detected 	 1 = No longer detected 	 2 = Detected now 
	 Error: Amplifier, in part or as a whole, has shut down or is misconnected.
Digital Clipping (64STAT): 			   	 0 = Not or never detected 	 1 = No longer detected 	 2 = Detected now 
	 Caution: Amplifier functionality has been modified to protect itself
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Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Status (continued)
View system over temp 
fault status

E53STAT} X9$] 53StatX9$]

NOTE: 	 This command displays the current over temp fault status of the power supply. Once the amplifier cools enough and recovers, the value is set  
from 2 to 1.

View DC protection fault 
status

E54STAT} X9%] 54StatX9%]

NOTE: 	 This command displays the current DC fault status. If the unit recovers, the value is set from 2 to 1. Power cycling may or may not recover the 
unit. If not, the amplifier may need to be serviced.

View thermal limiting 
status

E55STAT} X9^(1)*...X9^(n)] 55StatX9^*(1)...X9^(n)]

NOTE: 	 This command displays the current thermal limiting status of each output channel. Once the output channel cools enough and recovers, the 
value is set from 2 to 1. Each channel is represetned in the response as part of the string. “n” represents the output channel number. 

View Overload Protect 
status

E57STAT} X9*(1)*...X9*(n)] 57StatX9*(1)*...X9*(n)]

NOTE: 	 This command displays the status of the limiter, whether it is engaged or not. Once the limiter disengages, the value is set from 2 to 1. 		
Each channel is represented in the response as part of the string. “n” represents the output channel number. The limiter engages for both 		
current and power limiting. When a short is detected the affected channel shuts down.

KEY:	

X9$ = System Over Temp Values: 	
0 = System temperature was within the normal operating temperature range at the time the command checked the status and  
		  has not gone over the temperature threshold in the past.

1 = System temperature was within the normal operating temperature range at the time the command checked the status, but 
	 	 has gone over the temperature threshold in the past.

2 = System temperature was over the normal operating temperature range at the time the command checked the status. The 
	 	 Over Temp LED is on.

X9% = DC protect: 

0 = DC on any of the outputs was not detected at the time the command checked the status and has not gone over the 
		  temperature threshold in the past. 
2 = The amplifier was protecting itself from DC on any of the outputs at the time the command checked the status. The amplifier 
		  is in protection mode and does not come out of standby, and the power LED is amber. Power cycling may or may not 
		  recover the amplifier; the amplifier may need servicing.

X9^ = Output thermal limiting: (The left most X9^ represents output channel 1 and the right most X9^ represents the highest output channel.)

0 = The indicated amplifier channel was within its normal operating temperature range at the time the command checked the  
		  status and has not exceeded its normal operating temperature range in the past. 
1 = The indicated amplifier channel was within its normal operating temperature range at the time the command checked the  
		  status, but has gone over the normal operating temperature range in the past. 
2 = The indicated amplifier channel has exceeded its normal operating temperature range at the time the command checked the 
		  status. The indicated channel’s clip/protect LED is lit.

X9* = Overload Protect: (The left most X9* represents output channel 1 and the right most X9* represents the highest output channel.)

0 = The indicated amplifier channel limiter threshold was not reached, nor was a short detected, at the time the command  
		  checked the status and has not been reached/detected in the past. 
1 = The indicated amplifier channel limiter threshold was not reached, nor was a short detected, at the time the command 
		  checked the status, but it was reached/detected in the past. 
2 = The indicated amplifier channel limiter threshold was reached, or a short was detected, at the time the command checked  
		  the status. The indicated channel limiter is engaged, or if shorted it is muted, and the clip/protect LED is on.
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Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Status (continued)
View Output Open Circuit 
Status

E58STAT} X9((1)*...X9((n)] 58StatX9((1)*...X9((n)]

NOTE: 	 This command displays the current output channel open circuit fault status. Once the amplifier has detected that a load has been connected 
to the output, the value is set from 2 to 1. When there is insufficient signal to take a measurement, no changes are made to the status. Each channel 
is represented in the response as part of the string. “n” represents the output channel number.

Loss of AC E60STAT} X10!] 60StatX10!]

NOTE: 	 This command indicates if a disruption in power was detected or if a loss of AC is detected.

Main power supply status E61STAT} X10@] 61StatX10@]

NOTE: 	 This command displays the current power supply fault status. If the unit recovers, the value is set from 2 to 1. Power cycling may or may not 
recover the unit; the amplifier may need to be serviced.

Signal Presence E62STAT} X10#(1)*...X10#(n)] 62StatX10#(1)*...X10#(n)]

NOTE: 	 Each channel is represented in the response as part of the string. “n” represents the output channel number.

View Digital clip status E64STAT} X10^(1)*...X10^(n)] 64StatX10^(1)*...X10^(n)]

NOTE: 	 This command displays the status of digital clipping on the DSP outputs going to amplifier channel. Once digital clipping is no longer, 
detected, the value is set from 2 to 1. Each channel is represented in the response as part of the string. “n” represents the DSP output channel 
number.

KEY:	

X9( = Output open circuit: (The left most X9( represents output channel 1 and the right most X9( represents the highest output channel.)

0 = The indicated amplifier channel did not detect an open at the time the command checked the status and has not detected an 
		  open in the past. 
1 = The indicated amplifier channel did not detect an open at the time the command checked the status, but an open was 
		  detected open was detected in the past. 
2 = The indicated amplifier channel detected an open at the time the command checked the status.

X10! = Loss of AC: 

0 = Loss of AC was not detected at the time the command checked the status. 
1 = A disruption was detected in the past. 
2 = Loss of AC has been detected at the time the command checked the status.

X10@ = Main power supply status: 

0 = A fault on the main power supply was not detected at the time the command checked the status and has not been detected  
		  in the and has not been detected in the past. 
1 = A fault on the main power supply was not detected at the time the command the checked the status, but a fault on the main  
		  power supply has not been detected in the past. 
2 = A fault on the main power supply was detected at the time the command checked the status.

X10# = Signal presence status: (The left most X10# represents output channel 1 and the right most X10# represents the highest output 
channel.)

0 = No signal detected		  1 = Signal detected

X10^ = Digital clip status: (The left most X10^ represents output channel 1 and the right most X10^ represents the highest output channel.) 

0 = The indicated output channel did not detect digital clipping at the time the command checked the status and has not been  
		  detected in the past. 
1 = The indicated output channel did not detect digital clipping at the time the command checked the status, but has been  
		  detected in the past. 
2 = The indicated amplifier channel detected digital clipping at the time the command checked the status
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Command 
Function

SIS Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Status (continued)
Reset status EX99(ZSTS} ZstsX99(]

NOTE: Resets the flag of a selected status from 1 to 0. Each status can be selected, depending on the value of X99(. When X99( = 0, all flags are 
reset.

KEY:

X99( = Status 0 = Resets all "x" flags from 1 to 0; 53, 54, 55,57,58, 60, 61, and 64 = Resets the specific ##STAT's "x" flag(s) from one to 
zero.

Object ID (OID) Number Tables
The following tables list input and output gain OIDs. For mix-point OID tables, see Mix-point OIDs 
on page 100).

Input Path OIDs (NetPA U 1004)

Mic/Line Input Gain Block OID Mic/Line Pre-mixer Gain Block OID

Mic/Line Input 1 40000 Mic/Line Input 1 40100

Mic/Line Input 2 40001 Mic/Line Input 2 40101

Mic/Line Input 3 40002 Mic/Line Input 3 40102

Mic/Line Input 4 40003 Mic/Line Input 4 40103

AT Input MTR Block OID Mic/Line Pre-mixer Gain Block OID

AT Input 1 50000 AT Input 1 50100

AT Input 2 50001 AT Input 2 50101

AT Input 3 50002 AT Input 3 50102

AT Input 4 50003 AT Input 4 50103

Input Path OIDs (NetPA U 1002)

Mic/Line Input Gain Block OID Mic/Line Pre-mixer Gain Block OID

Mic/Line Input 1 40000 Mic/Line Input 1 40100

Mic/Line Input 2 40001 Mic/Line Input 2 40101

Mic/Line Input 3 40002 Mic/Line Input 3 40102

Mic/Line Input 4 40003 Mic/Line Input 4 40103

AT Input MTR Block OID Mic/Line Pre-mixer Gain Block OID

AT Input 1 50000 AT Input 1 50100

AT Input 2 50001 AT Input 2 50101
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Output Path OIDs (NetPA U 1004)

Amplifier Output Trim Block OID Amplifier Output Attenuation Block OID

Amp Output 1 60100 Amp Output 1 60000

Amp Output 2 60101 Amp Output 2 60001

Amp Output 3 60102 Amp Output 3 60002

Amp Output 4 60103 Amp Output 4 60003

Line Output Trim Block OID Line Output Attenuation Block OID

Line Output 1 60104 Line Output 1 60004

Line Output 2 60105 Line Output 2 60005

Line Output 3 60106 Line Output 3 60006

Line Output 4 60107 Line Output 4 60007

Output Path OIDs (NetPA U 1002)

Amplifier Output Trim Block OID Amplifier Output Attenuation Block OID

Amp Output 1 60100 Amp Output 1 60000

Amp Output 2 60101 Amp Output 2 60001

Line Output Trim Block OID Line Output Attenuation Block OID

Line Output 1 60102 Line Output 1 60002
Line Output 2 60103 Line Output 2 60003

AT Output Trim Block OID AT Output Attenuation Block OID

AT Output 1 60104 AT Output 1 60004

AT Output 2 60105 AT Output 2 60005

Mix-point OIDs
NOTE:	 In these tables, inputs are listed vertically along the left side of the table and outputs are 

listed horizontally across the top of the table.

Mic/Line and Digital Input to Analog and Aux Output Mix Matrix 
(NetPA U 1004)

Amp Out 1 Amp Out 2 Amp Out 3 Amp Out 4 Line Out 5 Line Out 6 Line Out 7 Line Out 8

Mic In 1 20000 20001 20002 20003 20004 20005 20006 20007

Mic In 2 20100 20101 20102 20103 20104 20105 20106 20107

Mic In 3 20200 20201 20202 20203 20204 20205 20206 20207

Mic In 4 20300 20301 20302 20303 20304 20305 20306 20307

Digital AT In 5 20400 20401 20402 20403 20404 20405 20406 20407

Digital AT In 6 20500 20501 20502 20503 20504 20505 20506 20507

Digital AT In 7 20600 20601 20602 20603 20604 20605 20606 20607

Digital AT In 8 20700 20701 20702 20703 20704 20705 20706 20707
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Troubleshooting

The front and rear panels have LED warning indicators, as described below.

Amplifier Fails to Exit Standby Mode Promptly
The input channel signal LED lights green when an input signal is detected.

Power LED Color Signal LED State Problem Description Problem Solution

Amber Not Lit No output signal No input detected. Verify the input signal. If an 
input signal is present, raise the input level until 
signal LED lights.

Green or Amber Lights Intermittently Unit does not promptly 
exist standby mode when 
inputs signal is present

The output signal level of the source may 
be too low to cross the signal detection 
threshold of the amplifier (see amplifier specs at 
www.extron.com, for details).
Increase the signal level of the source until the 
signal LED lights consistently, or defeat the 
standby timer.

Amber Lit No output signal Amplifier has been placed in standby mode and 
the output has been turned off. Check remote 
port and SIS. DC Fault may have been detected.

Amber Lit DC Fault is detected. Unit 
does not exit standby.

Verify, through DSP Configurator or the status 
commands, if a DC fault has been detected. 
Disconnect power, then disconnect the standby 
port. Reconnect power to the unit to determine 
if the unit immediately goes into standby mode 
upon power up. The amplifier may need to be 
serviced.

Amplifier Enters Standby Mode Too Early
The input channel signal LED lights green per indicated input channel when an input signal 
is detected.

Power LED Color Signal LED State Problem Description Problem Solution

Green or Amber Lights Intermittently Enters standby mode early The output signal level of the source may 
be too low to cross the signal detection 
threshold of the amplifier (see amplifier specs at 
www.extron.com, for details).
Increase the signal level of the source until the 
signal LED lights consistently or defeat the 
standby timer.

https://www.extron.com
http://www.extron.com
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Limiter/Protect LED Warning Indicators
The output channel Limiter/Protected LED lights green per indicated input channel when an 
input signal is detected.

LED State Problem Description Problem Solution

Blinks Audio clipping is occurring at the rate 
of one blink per clip.

Reduce the power output to avoid overdriving the amplifier and 
causing clipping

Lights steadily The amplifier may be overheating. Determine the reason for the overheated state and allow the 
amplifier to cool. The LED resumes its normal operation after the 
amplifier recovers from the overheated state.

Output channel leads are shorted. Check speakers and speaker wiring for shorts.

Over Temp Indicator LED
This indicator does not represent a hard failure of the unit. It is a warning the amplifier has 
exceeded the recommended operating temperature for optimal product lifetime.

LED State Problem Description Problem Solution

Lights steadily Amplifier has exceeded the 
recommended operating temperature. 
The LED turns off after the amplifier 
cools down.

•	 Verify that the placement of the amplifier allows for suitable 
ventilation and airflow Rack Mounting Ventilation 
Recommendations on page 9.

•	 Avoid placing equipment on top or below the amplifier.
•	 Verify that the operating temperature is within the specified 

range.

Status Commands

NOTE:	 Status flags automatically reset when the amplifier is power cycled.

Status Possible Triggers Possible Causes Possible Solutions

53STAT: Over Temp The amplifier has 
exceeded the 
recommended operating 
temperature.

See specifications.

The ambient environment exceeds 
the recommended operating 
temperature.

•	 Verify that the placement of 
the amplifier allows for suitable 
ventilation and airflow.

•	 Avoid placing equipment on top or 
below the amplifier.

•	 Verify that the operating 
temperature is within the specified 
range.

54STAT: DC 
Protection

A DC signal has been 
detected on an amplifier 
channel.

Hardware failure. •	 Disconnect power then reconnect 
power to the unit to determine if the 
unit immediately goes into standby 
upon power up.

•	 The amplifier may need to be 
serviced.

55STAT: Output 
Thermal limiting

The specified amplifier 
channel has overheated 
and is muting the 
affected channel.

•	 The channel is driving too low 
of a speaker load impedance.

•	 The channel is being fed 
a heavily clipped/distorted 
signal.

•	 The amplifier operating 
environment exceeds the 
recommended operating 
temperature.

•	 Make sure the correct speaker load 
is connected.

•	 Check that speakers are tapped 
appropriately.

•	 Recheck the amplifier gain 
structure.

•	 Verify that the amplifier ambient 
environment does not exceed 
the recommended operating 
temperature (See 53STAT).
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Status Possible Triggers Possible Causes Possible Solutions

57STAT: 
Overload

•	 The current/power 
limiter has been 
triggered.

•	 A short on the 
affected output 
channel has been 
detected.

•	 Too much current is being 
drawn due to overdriving the 
output.

•	 An improper speaker load 
has been attached (for 
example: Attaching a low 
impedance speaker to a high 
impedance output).

•	 The output has been shorted.

•	 Recheck the amplifier gain 
structure.

•	 For low-impedance loads: Verify 
that total impedance at the amplifier 
is ≥ 4 ohms.

•	 For 70V/100V speaker loads: 
Recheck speaker taps.

•	 Check for shorts at the output and 
throughout the speaker chain.

58STAT: Open 
Circuit

•	 The affected 
channel has 
detected an open 
circuit.

•	 The connection to the 
speaker chain has been 
broken.

•	 An improper speaker load 
has been attached (for 
example Attaching a high 
impedance speaker to a low 
impedance output).

•	 No speaker load is attached.

•	 Check for an open circuit at the 
output and throughout the speaker 
chain.

•	 Recheck speaker taps.

60STAT: Loss of AC •	 If a “2” is reported: 
Loss of AC is 
detected.

•	 If a “1” is reported: 
A momentary loss 
of AC power has 
been detected in 
the past.

There is or has been a disruption 
in power.

Check the system power distribution.

61STAT: Main 
power supply fault

The main power supply 
has shut down for 
reasons other than 
loss of AC, going into 
standby, or DC protect 
and is effectively muting 
all output channels.

•	 The power supply has 
overheated.

•	 There is a damaged 
component.

•	 Allow the amplifier to cool down.
•	 Make sure the correct speaker load 

is connected.
•	 Check that speakers are tapped 

appropriately.
•	 Recheck the amplifier gain 

structure.
•	 Verify that the amplifier’s ambient 

environment does not exceed 
the recommended operating 
temperature (see suggestions for 
53STAT)

•	 If none of the above work, power 
cycle the amplifier. If that does not 
work, the amplifier may need to be 
serviced.

62STAT: Signal 
presence

A signal has been 
detected

N/A N/A

64STAT: Digital clip The output DAC to the 
amplifier channel has 
detected clipping.

The output DAC is being 
overdriven.

Recheck the amplifier gain structure.
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Status Possible Triggers Possible Causes Possible Solutions

PSAV (Standby) The unit has been 
placed into standby.

•	 The auto-standby timer has 
timed out.

•	 The contact closure port is 
engaged on the rear panel.

•	 SIS has forced the unit into 
standby.

•	 DC has been detected on an 
output.

•	 Check that there is sufficient signal 
going to the amplifier channel.

•	 Check that the standby port is not 
engaged.

•	 Check that the SIS is not forcing the 
unit into standby.

•	 If none of the above work, check 
for a DC fault (see Monitoring 
Configuration 2 on page 95)
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Mic/Line and Digital Input to Analog and Aux Output Mix Matrix 
(NetPA U 1002)

Amp Out 1 Amp Out 2 Line Out 1 Line Out 2 Digital AT Out 1 Digital AT Out 2

Mic In 1 20000 20001 20002 20003 20004 20005

Mic In 2 20100 20101 20102 20103 20104 20105

Mic In 3 20200 20201 20202 20203 20204 20205

Mic In 4 20300 20301 20302 20303 20304 20305

Digital AT In 1 20400 20401 20402 20403 20404 20405

Digital AT In 2 20500 20501 20502 20503 20504 20505



Contact Information

Worldwide Headquarters:  Extron USA West, 1025 E. Ball Road, Anaheim, CA 92805, 800.633.9876

Extron Warranty

Extron warrants this product against defects in materials and workmanship for a period of three years from the date 
of purchase. In the event of malfunction during the warranty period attributable directly to faulty workmanship and/
or materials, Extron will, at its option, repair or replace said products or components, to whatever extent it shall 
deem necessary to restore said product to proper operating condition, provided that it is returned within the warranty 
period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America:
Extron 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

Asia:
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Japan:
Extron Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe:
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China:
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Africa and Middle East:
Extron Middle East 
Dubai Airport Free Zone 
F13, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process.

	 USA:	 714.491.1500 or 800.633.9876	 Asia:	 65.6383.4400 

	 Europe:	 31.33.453.4040 or 800.3987.6673	 Japan:	 81.3.3511.7655
	 Africa and Middle East:	 971.4.299.1800 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.
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